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What’s New in This Guide

This section introduces the documentation updates for Release 14.0 in Oracle Communications LSMS Full Upgrade
Guide.

Release 14.0 — F91165-10, September 2025

e Updated step 14 in Procedure 11, Install the LSMS Application and added a note that default permission
and ownership will automatically be added to the config file for Ismsadm user.

o Edited step 10 in Procedure 19, Restore Database that Procedure 18 needs to be executed to verify the
system health check after DB full upgrade.

e Added a note to Procedure 22. that the procedure is only required when ELAP version is 10.2.
Release 14.0 — F91165-09, August 2025

o Updated the release versions in the Full Upgrade Paths table.

e Added a note in step 8 in Procedure 6, Backup LSMS DB that the edit supDBdump.sql to fix authorization
table command is only required while upgrading from 13.X release.

e Updated step 9 in Procedure 6, Backup LSMS DB with information on migrating from 14.0.0.X to 14.0.0.Y
by editing the file MySQLUserGrants.sql.

e Added step 14 in Procedure 11, Install the LSMS Application to create config file in the SSH directory

e Updated step 6 in Procedure 19, Restore Database with a command to restore supDB.

Release 14.0 — F91165-08, April 2025

e Added step 3 in Procedure 6, Backup LSMS DB to disable LSMS backup on both A and B servers

Release 14.0 — F91165-07, November 2024

e Added thecommand # rm -rf /var/TKLC/lsms/free/<regionDB> to extractthe snapshot data
from the archive tar files copied from LSMS in step 5 in Procedure 19.

e Updated the command to exchange key with remote ELAP and LSMS in step 4 and 5 in Procedure 22.

e Removed step 7 from Procedure 22.

Release 14.0 — F91165-06, October 2024

Updated the note about valid licenses to be installed on LSMS A and B servers in the Procedure 16, TMN Toolkit and
Marben OSI License Installation section.

Release 14.0 — F91165-05, September 2024

e Added a note in step 7 in Procedure 6, Backup LSMS DB to take a note of EMS configuration.

e  Added information about editing the MySQLUserGrants.sql file in Procedure 6, Backup LSMS DB.

e Added information about a warning displayed during the upgrade in step 11 in Procedure 11, Install the LSMS
Application.

Release 14.0 — F91165-04, September 2024



Updated the Required Materials section to add reference to Release Notes to access the procedure to obtain the license
key files for Marben OSI and TMN Toolkit from Artifex for successful communication between LSMS and NPAC.

Release 14.0 — F91165-03, August 2024

Updated the Required Materials section.

Added a note in the Upgrade Timeline for LSMS Procedure Execution Order section.
Updated the note in step 4 in Procedure 6, BACKUP LSMS DB.

Updated step 8 in Procedure 6, BACKUP LSMS DB.

Updated Procedure 10, Configure Network Interface Using Platcfg Utility.

Added a note in Procedure 15, Segmented Configuration for LSMS Cards.

Updated step 2 in Procedure 16, TMN Toolkit and Marben OSI License Installation.
Removed the Appendix “Procedure to Procure TMN and Marben Licenses”.
Replaced the reference to Appendix F with Appendix E throughout the document.

Release 14.0 — F91165-02, June 2024

e  Added the procedure for SSH Key Exchange between ELAP and LSMS.
e  Updated the reference to Procedure 22 in Timeline table for Maintenance Window Task.
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1. INTRODUCTION

1.1 Purpose and Scope

This document is designed to detail the steps necessary to upgrade the functionality of the LSMS 13.5.X. on ESAPPB-
02 to the LSMS 14.0.0.Y on the ESAPPB-02 cards.

This work is intended to be non-intrusive to the signaling network traffic and is to be performed within the limits of a
normally scheduled maintenance window unless otherwise stated.

It will be necessary to halt the provisioning activity during the execution of the procedures outlined herein while a full
database backup is being taken. Normal provisioning can resume once the full upgrade has completed. For any issues
incurred in executing any part of this document, follow the contact/escalation list.

The individual executing this procedure must be experienced and well proficient with the following platforms and
technologies.

e  Unix/Linux Admin

e VI Editor

e |P Networking

e Oracle LSMS Platform E5-APP-B (TPD through Initial Implementation)

If you do not have these skills or if you are not completely comfortable working in Unix or Linux system environment,

STOP - DO NOT PROCEED

Full Upgrade for LSMS 14.0 14.0

08



1.2 References

(1]
(2]
(3]
(4]
(5]
(6]

Formal Peer Review, PD001866, latest version

Work Instruction Template, TM005023, latest version

Oracle Quality Manual, latest version

TPD Initial Product Manufacture User’s Guide, 909-2130-001, Latest revision, Oracle
ELAP 11.0 Full Upgrade/Installation Procedure, Current Version, Oracle
Query Server Installation and Upgrade Instructions, Latest Version, Oracle

1.3Acronyms

Table 1. Acronyms

BIOS Basic Input Output System

DB Database

E5-APP-B/ESAPPB Eagle5 Application Card class B cpu/board
E5APPB-02 E5 Based Application card installed with 480G SSD Hard Drive
ELAP Eagle LNP Application Processor

IPM Initial Product Manufacture

LSMS Local Service Management System

NAS Network Attached Storage

NPAC Number Portability Administration Centre
QS Query Server

SERVDI Support ELAP Reload Via Database Image
TPD Tekelec Platform Distribution

MPS Multi Purpose System

1.4 Definitions

Table 2. Definitions

Active LSMS

LSMS on which the sentry is running and it takes updates from the NPAC.

Standby LSMS

LSMS on which data is replicated from the Active LSMS.

System health check

Procedure used to determine the health and status of the LSMS server, typically
performed using the TPD syscheck utility.

1.5Terminology

Multiple servers may be involved with the procedures in this manual. Therefore, most steps in the written procedures
begin with the name or type of server to which the step applies. For example:

Eech sfep has acheckbox for every cormmmeard within the sfep that the
fechwician shadd check fo kesp frad of the progress of the procedure.

Thefifle box describes fhe operafions fo be performed duving that sfep.

Each command that the fechnicianis fo emfer isin 5 point Lucida Console fonf

\




1 | MPS A: Verify all | Materials are listed in Material List (Section 1.6)
D materials required
are present

Figure 1. Example of a step that indicates the Server on which it needs to be executed

1. | 1A | 18 | MPS X: Insert Insert media in USB drive
USB.
O O

Figure 2. Example of a step that needs to be executed on both MPS A and MPS B servers

1.6 Required Materials

e LSMS 14.0 works on OL8.x and needs license key files for Marben OSI and TMN Toolkit from Artifex for
successful communication between LSMS and NPAC. Make sure to get the two license key files from Artifex
before the scheduled upgrade date. Refer to LSMS 14.0 Release Notes, section 3.3: Marben OSI and TMN
Toolkit license key files, for details. Make sure to start the process at least 7 days before the scheduled upgrade
date.

e Two (2) target-release TPD USBs

e Two (2) target-release LSMS USBs or a target release LSMS ISO file.

e Aterminal and null modem cable to establish a serial connection.

e 100mbps link is required for database transfer to remote server.

e Remote Server or NAS server to store DB Backup before migration.

e TMN and Marben OSI license for OL8 server

e Type of Network configuration single/segmented

e  System configuration information like NTP Server IP, App IP, ELAP IP etc.
Write down the system configuration information.
App IP:
App Gateway:
NTP Server IPs:

ELAP Server IPs:
NPAC Server IPs:
NPAC Customer ID:
NMS IPs:

Other IPs required:

Remote Server IP to copy DB Backup:

e  Passwords for users on the local system:

LSMS USERS
login MPS A password MPS B password
Ismsmgr
Ismsadm
Ismsall
Ismsuext

Full Upgrade for LSMS 14.0 14.0
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Ismsuser
Ismsview

root

mysql dbroot user
admusr
Command-line

Table 3: User Password Table

Note: After the MPS servers are IPM’ed with TPD 7.5.x, then “root” user access is disabled. “admusr” can be used if
required to access the MPS servers. After the installation of LSMS application the “root” user access is again enabled.

1.7E5APPB Server (Rear)

ol
—
()
ol
D
o
©
o

Figure 3. E5-APP-B Server (Rear)

1.7 Switch Configuration

VLAN configuration on the switch is done based on the LSMS/NAS Segmented Type Configuration. Please note that
the VLAN IDs can be different based on the LAB network configuration.

Name |V Tag| Rout If | Tagged ports | Untagged ports

default |1 | swO | [1/1/1-1/1/24

vlan2 |2 | |1/1/3,1/1/4 |

vlan3 |3 |]1/1/3,1/1/4 |

naspri-network |5 | |1/1/3,1/1/4,1/1/17 |



nassec-network |6 | |1/1/3,1/1/4,1/1/18 |
elap-network |159 | |1/1/3,1/1/4,1/1/19 |
gui-network |161 | |1/1/3,1/1/4,1/1/20 |

Optionally assign some name to the switch ports:

interface 1/1/3

name LSMS-A_NAS/ELAP/GUI
!

interface 1/1/4

name LSMS-B_NAS/ELAP/GUI
1

interface 1/1/17

name LSMS-A_NAS-pri

!

interface 1/1/18

name LSMS-B_NAS-sec

!

interface 1/1/19

name ELAP-network-uplink

]

interface 1/1/20

name Gui-network-uplink

1.8 Fallback

If for any reason a fallback to the original configuration is required, the procedure will be to re-IPM the server and

install the old LSMS version.

2. GENERAL DESCRIPTION

This document defines the step-by-step actions performed to execute a software full upgrade to ESAPPB-02.

The LSMS application can be installed or upgraded based on the table below.

Table 4 Install-Full Upgrade paths for ESAPPB-02

TPD Release for IPM LSMS Initial Installation Release
8.10.1.5.0_150.14.0 or later 14.0.Y
Full upgrade Source Release Full upgrade Destination Release
135.X 14.0.0.Y
14.0.0.X 14.0.0.Y

*Note : LSMS 14.0.Y is supported on E5APPB-02 cards only

The LSMS upgrade paths are shown in the figures below. The general timeline for all processes to perform a software
upgrade, from pre-upgrade backups to a final system health check, is also included below.
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This document covers
migration from LSMS 13.5;to
LSMS 14.0

LSMS 13.5x-yyy | ’ LSMS 14.0 .a-b.b.b

on an ESAPPB-02 Migrate on an ESAPPB-02

Figure 4: Full upgrade Path - LSMS 13.5.X to 14.0.Y

This document covers migration from
Migration from LSMS 14.0.0.X to 14.0.0.Y

LSMS 14.0.0.0.X LSMS 14.0.0.0.Y

On an E5APPB-02 On an E5APPB-02

Figure 5: Full upgrade Path - LSMS 14.0.0.X to 14.0.0.Y

3. FULL UPGRADE PROCEDURES
3.1 Upgrade Timeline for LSMS Procedure Execution Order

NOTE: Before starting the procedure make sure you have all the required information listed in section 1.6. Do
not proceed further until you have this required information, missing any information will be fatal post
upgrade.

3.1.1.1 Preparation phase

Before planning or starting Full Upgrade to LSMS 14.0 customer will have to procure TMN and Marben
Licenses for NPAC connection to work on OL8 post upgrade. Contact My Oracle Support (3.7Appendix E) to
procure the licenses.



Table 5: Timeline table for full upgrade preparation

LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
Procedure 1 Setup upgrade environment 5 0
5 5 | Setup upgrade Procedure 1
environment
Procedure 2 Pre Full upgrade Health 5 10 5 | Pre Full upgrade Health Procedure 2
Check Check
Procedure 3 Verify LSMS QS 10 20
30

3.1.1.2 Maintenance Window Tasks

Table 6: Timeline table for Maintenance Window Task

LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
Direct Disconnect 10 0
Procedure 5 SSH NPAC from
LSMS
Procedure 4 Disconnect
ELAP from
LSMS
Procedure 6 Direct Backup LSMS 120 10 10 | IPM MPS B Minicom | Procedure 8
SSH DB 0 | serverand NAS mate for
server MPS B
Transfer and
Procedure 7 Database to Minicom
Remote Server nas for
NAS
server

Full Upgrade for LSMS 14.0 14.0 014



Pre-Install Minicom | Procedure 9
Configuration mate
Install the Minicom | Procedure 11
Application mate
Configure Minicom | Procedure 10
Network mate
interfaces using
platcfg utility
Configure Time | Minicom | Procedure 13
Zone and Clock. | mate
TMN Toolkit Minicom | Procedure 16
and Marben OSI | mate
License
Installation
Procedure 8 Minicom | IPM MPS A 60 130
mate server
Procedure 9 Pre-Install
Configuration
Procedure 11 | Minicom | Install the 25 190
mate Application
Procedure 12 | Minicom | LSMS Initial 15 215
mate Configuration
Procedure 13 | Minicom | Configure Time 5 230
mate Zone and Clock.
Procedure 14 | Minicom | Network 10 235
OR mate Configuration
Procedure for LSMS Cards.
15.
*Note: For
Single Subnet
Configuration
execute
Procedure 14
and for
Segmented
Subnet
Configuration
execute
Procedure 15.
Procedure 16 | Minicom | TMN Toolkit 5 245
mate and Marben OSI
License
Installation
Procedure 17 | Minicom | Start LSMS 10 | 250
mate services
Procedure 18 | Minicom | Post 5 260
mate Configuration

Health Check




Procedure 19 | Minicom | Restore Database | 60 | 265
mate
Procedure 20 | Minicom | Connect LSMS 15 | 325
mate 14.0.X to NPAC
Procedure 22 | Direct SSH Key 15 | 340
SSH Exchange
Between ELAP
and LSMS
Procedure 23 | Minicom | Connect LSMS 10 350 5 | Acceptthe Direct Procedure 24
mate 14.0.X to ELAP upgrade SSH
Procedure 24 | Minicom | Acceptthe 5 355
mate upgrade
Upgrade 355
Completed
3.1.1.3 Post Upgrade Phase
LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
Procedure 21 | Export the Database from 60 0
LSMS 14.0.X to the Query
Server
60

3.2Install Procedures
This procedure will be executed for customers who are installing LSMS application on new server or are not using
LSMS application before this release. All other customers migrating from 13.5 release will have to follow Full Upgrade

Procedure.

3.2.1.1 Maintenance Window Tasks

Table 7: Timeline table for Maintenance Window Task

LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
Procedure 8 Direct IPM MPS A 120 0 0 | IPMMPSB Direct Procedure 8
Serial/Mi | server server and NAS Serial/Mi
nicom server nicom
Connecti Connecti
on on
Procedure 9 Pre-Install Pre-Install Procedure 9
Configuration Configuration

Full Upgrade for LSMS 14.0
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Procedure 11

Procedure 13

Install the
Application

Configure Time
Zone and Clock.

Install the
Application

Configure Time
Zone and Clock.

Procedure 11

Procedure 13

Procedure 12 | Direct LSMS Initial 15 120
Serial/Mi | Configuration
nicom
Connecti
on
Procedure 13 | Direct Configure Time 5 135
Serial/Mi | Zone and Clock.
nicom
Connecti
on
Procedure 14 | Direct Network 10 140
OR Serial/Mi | Configuration
Procedure 15 | nicom for LSMS Cards.
Connecti
on *Note: For
Single Subnet
Configuration
execute
Procedure 14
and for
Segmented
Subnet
Configuration
execute
Procedure 15.
Contact Procure Procure TMN - - | Procure TMN Procure Contact
Oracle TMN License License TMN Oracle
Support License License Support
Note: Timing to Note: Timing to
acquire TMN acquire TMN
license may wary license may
depending on wary depending
Artifex team on Artifex team
availability. availability.
Procedure 16 | Direct TMN Toolkit 5 150
SSH and Marben OSI
License
Installation
155 5 | TMN Toolkit Direct Procedure 16
and Marben OSI | SSH
License
Installation
Procedure 17 | Direct Start LSMS 10 160
SSH services
170 10 | Start LSMS Direct Procedure 17
services SSH




Direct Post 5 180

Procedure 18 | SSH Configuration
Health Check
185 5 | Post Direct Procedure 18
Configuration SSH
Health Check
Procedure 20 | Direct Connect LSMS 15 | 190
SSH 14.0.X to NPAC
Procedure 23 | Direct Connect LSMS 10 205 5 | Acceptthe Direct Procedure 24
SSH 14.0.X to ELAP upgrade SSH
Procedure 24 | Direct Accept the 5 215
SSH upgrade
Upgrade 220
Completed

3.3Pre Full upgrade Steps
Check off () each step as it is completed. Boxes have been provided for this purpose under each step number.

Should this procedure fail, Contact My Oracle Support following the instructions on the Appendix E.
Procedurel  SETTING UP FULL UPGRADE ENVIRONMENT

Procedure 1 - Setting Up Full upgrade Environment

S . .
T This procedure sets up the full upgrade environment.
E A B . . .
P Estimated time: 5 minutes
#
MPS X: SSH to MPS IP:
(0] 0 Login as root to MPS login: root
Password: <root_password>
MPS X: Start a capture_file using Iso Console, or by
2 Ol O : ) starting a local screen session and capturing
' Start capture file. its output.
MPS X:
3, (1| [J | Accessmate MPSvia # minicom mate
serial console
. console Togin: root
4 Ol O mate MPS: Password: <root_password>
: Login as root.
This procedure is complete!

Procedure 2 PRE-FULL UPGRADE SYSTEM HEALTH CHECK

Note: This procedure may be executed outside of the maintenance window.

This procedure determines the health of the MPS before and after full upgrade.

Estimated time: 5 minutes

P lom-dwn

MPS A and B: Log in to Login: root
. the server as the user “root”. Password: <root_password>

Full Upgrade for LSMS 14.0 14.0
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MPS A and B:

Validate date, time and time
zone to ensure accuracy.

# date
Thu May 12 05:55:27 EDT 2016

Execute the following command on both LSMS A and B to verify the HA state of

3. | MPS A and B: 4 LSMS pai
]| Execute the “hastatus™ mated LSMS pair.
command-to verify the HA # hastatus
state of this server.
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than
“ACTIVE” and “STANDBY”, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
4. | LSMS Standby server: Execute the following command to verify that MySQL replication is working
[ Verify that the STANDBY correctly on the STANDBY LSMS server:
server’s MySQL replication | # tail /var/TKLC/Tsms/Tlogs/dbreplMon.log
is functioning properly. If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.
Thu Dec 07 05:58:12 2017 ATl tests passed on STANDBY
Thu Dec 07 05:59:19 2017 ATl tests passed on STANDBY
Thu Dec 07 06:00:25 2017 ATl tests passed on STANDBY
Thu Dec 07 06:01:32 2017 A1l tests passed on STANDBY
WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
5. | LSMS Active server: Execute the following command to verify that MySQL replication is working

Verify that the ACTIVE
server’s MySQL replication
is functioning properly.

correctly on the ACTIVE LSMS server:
# tail /var/TKLC/Tsms/logs/dbreplmon. log

If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.

Thu Dec 07 05:58:12 2017 ATl
Thu Dec 07 05:59:19 2017 All
Thu Dec 07 06:00:25 2017 All
Thu Dec 07 06:01:32 2017 ATl

tests passed on ACTIVE
tests passed on ACTIVE
tests passed on ACTIVE

tests passed on ACTIVE

WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.




o

[l

MPS A and B:
Execute syscheck

# syscheck

Running modules 1in class disk..

OK
Running modules in class services...
OK
Running modules in class system...
OK
Running modules in class lIsmshc...
OK
Running modules in class hardware...
OK
Running modules in class proc...
OK
Running modules in class net...
OK

LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log

~

O

LSMS Active server:

Capture the output of
‘sentry status” command

Execute the following command on the ACTIVE LSMS server to display the
current LSMS sentry status:

# sentry status

NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment
field. If the output from this command displays any other Status than “running”
contact My Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

LSMS Active server:

SSH to NAS server and
execute syscheck.

# ssh backupserver
# syscheck

Running modules in class disk..
OK

Running modules in class services...
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oK

Running modules in class system...
OK

Running modules in class Ismshc...
oK

Running modules in class hardware...

OK
Running modules in class proc...

OK
Running modules in class net...

OK

LOG LOCATION: /var/TKLC/log/syscheck/fail_Tlog

©

Note down the Time zone

Note the time zone which will be required to be configured post upgrade.

# su - Tsmsmgr

Select Server Configuration and press [ENTER].
Main Menu |—
Initial Configuration
Maintenance
Diagnostics

Hetwork Configuration
Exit

Select Time Zone and press [ENTER].
- Server Configuration Menu |

S5et Clock

Time Zone

Exit

The screen shows the current time zone setting.




bWl gggqgu Options tgggggk -

£

shieg: x Exit x
moggagg] maggogda]

LR

[mogggggaaagggaaaaaqay’

10| Repeat on the day of the All Health Checks should be repeated the day of the full upgrade. If any problems
[ scheduled full upgrade are encountered, resolve before proceeding further.

This procedure is complete!

Procedure 3 VERIFY LSMS QUERY SERVER

Procedure 3 - Verify LSMS Query Server

? This procedure determines if the LSMS 13.5 has an Optional Query Server.
E . . .

p | Estimated time: 10 minutes

#

1. | LSMS Active server:

Login: Tsmsadm
1| Logintotheserverasthe | Password: <lsmsadm_password>

user “Ismsadm”.

N

LS!\/IS_ACtive Server. $ /usr/TKLC/1sms/tools/TIsmsdb -c queryservers
[]| Verify if the Query Server | /usr/TKLC/1sms/tools/Tsmsdb: Query Server Feature is not
Feature is active on the enabled.

LSMS System. -——OR---

cs2-bss2 (<LSMS Query Server IP>) Connected
___OR___

cs2-bss2 (<LSMS Query Server IP>) Disconnected

w

LSMS Active server:

]| Note down the Query
Server IP Address (es).

If the Query Server exists on the LSMS System, note the IP address (es) for later use.

This procedure is complete!

3.4 Data Backup before Full upgrade
Procedure 4 DISCONNECT ELAP FROM LSMS

Procedure 4 - Disconnect ELAP from LSMS
This procedure disconnects the ELAP from LSMS.Estimated time: 5 minutes

Note: This procedure needs to be executed on all the connected ELAPs.

HF oOom-dw
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1| ELAP Active server: NOTE: Verify the following.
[] | Verify ELAP 10.2 install ) ) )
1. ELAP 10.2 is successfully installed and configured.
2. ELAP 10.2 is connected to Eagle for data download
2. | LSMS Active server: Login: 1smsadm
]| Log in to the server as the Password: <lsmsadm_password>
user “Ismsadm”.
3. | LSMS Active server: b eagle status
0 Eli_s'g\g””ea the connected Look for all connected ELAPs and disconnect each of them.
s
$ eagle stop <ELAP CLLI>
eagle: Sto?ping. ..
eagle: eagleagent STPA stopped at Tue Apr 26 05:48:52 2023
4. | ELAP Active server: . . .
(7| Login to ELAP GUI Login to the ELAP (connected to LSMS) GUI through VIP as uiadmin.
5. | ELAP Active server: .
[ | Disable the Bulk Download Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
sable the Bu ownfoa Click on ‘Disable LSMS Bulk Download for this ELAP’ button.
ELAP_A_NAME Change LSMS HS Bulk Download Enabled
i INFO: The LSMS Bulk Download for this ELAP is currently Enabled.
& CAUTION: This action will Disable the LSMS Bulk Download for this ELAP
[ Disable LSMS Bulk Download for this ELAP
ELAP_A_NA[VIE Change LSMS HS Bulk Download Enabled
v SUCCESS: The LSMS Bulk Dowaload for this ELAP is now Disabled.
6. | ELAP Active server: Got Maint LSMS C i ch Enabled
. 0 to menu Maintenance -> onnection -> Change Enable
O ([:)cl)snar?;gtfgre] LSMS Click on ‘Disable LSMS Connection’ button.

ELAP_A_NAME Change LSMS Connection Allowed

1 INFO: The LSMS Connection is currently Enabled.

& CAUTION: This action will Disable the LSMS Connection.

Disable LSMS Coni

2013 © Tekelec, Inc., All Rights Reserved.

ELAP_A_NAME Change LSMS Connection Allowed

V SUCCESS: The LSMS Connection is now Disabled.

2013 © Tekelec, Inc, All Rights Reserved.




All connected ELAPS:

[] | Disconnect LSMS
connection

~

Repeat the steps 4 to 6 for all ELAPs connected to LSMS.

This procedure is complete!

Procedure 5 DISCONNECT NPAC FROM LSMS

Procedure 5 - Disconnect NPAC from LSMS

Estimated time: 5 minutes

This procedure disconnects NPAC from LSMS.

LSMS Active server:

Log in to the server as the
user “Ismsadm”

|:| P l#xomdwn

Login: Tsmsadm
Password: <lsmsadm_password>

LSMS Active server:

Stop all connected NPAC
regions

L~

Execute the following command to list the active NPAC regions

$ dbnames -n alTl -a

Canada CanadaDB

MidAtlantic MidAtlanticDB

Midwest MidwestDB

Northeast NortheastDB

Southeast SoutheastDB

Southwest SouthwestDB

westCoast WestCoastDB

western westernDB

Note: The above output shall vary depending on LSMS configuration.
Note: Store this output as it will be required during DB restore phase post

upgrade.

Execute the following command to stop an NPAC region.
$ 1sms stop <region name>

Checking if npacagent is running. ..Yes.

Stopping npacagent....
OK.

npacagent stopped: Wwed Jan 2 05:52:42 2014

Command complete.

Execute the above command for all active regions.

LSMS Active server:
Login to LSMS GUI

L] e

Login to LSMS Active GUI through VIP as ‘Ismsall” user.

LSMS Active server:
Deactivate all active regions

]~

Click on the NPAC region.
Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Uncheck the ‘Activate Region’ checkbox and click ‘OK”.
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7. Modify LNP System NPAC <Canada, primary> [==3a]
SMS Name |Regions MPAC Canada Attivate Region

Address Info | Component Info | Contact Info | Comm Info
WPAC O3] Address

PSEL |cwe7 SSEL |ow? TSEL N3AP (10 |248 |10 |5

LSMS OS5l Address

PSEL psel S5EL ssel TSEL NSAP 10 248 1o 78

MPAC FTP Address

10 248 |10 |5

|z| Modify NPAC Component?

oK Cancel

Note: Similarly, Deactivate all the active NPAC regions.

This procedure is complete!

Procedure 6 BACKUP LSMS DB

Procedure 6 - Backup LSMS DB

? This procedure outlines the steps to backup the LSMS DB.
E | Estimated time: 90 minutes
P
# | NOTE: The estimated time may differ depending on the DB size.
1 LSMS Active server: Login: root
' ) ' Password: <root_password>
[] | Login to the server as the
user “root”
2. LSMS Active server: # Tsmsdb —c counts
[] | Record DB counts
3. i . .
LSMS Active a.nd isabl Run the following command on both LSMS A and B to disable LSMS backup:
Standby Server: Disable | # sed -i '/A#/1 {/1smsbkp_wrapper/ s/A/#/}'
LSMS backup on both A | /etc/cron.d/1smsbkp.cron
and B servers
4. LSMSAC“_VE_ Server. # rm -rf /var/TKLC/Tsms/free/mysql-snapshot-*
(] | Remove existing DB # rm -rf /var/TKLC/Tsms/free/snapinfo.sql

snapshots




5, LSMS Active server: Execute below command to verify “QUERY_SERVER” and
“RESYNCDB QUERY_ SERVER” feature is enabled:
[ ] | Enable - -
“QUERY_SERVER” and | # Tsmsdb -c features | grep -w QUERY_SERVER
“RESYNCDB_QUERY S # Tsmsdb -c features | grep —w RESYNCDB_QUERY_SERVER
ERVER?” Feature
If these features are not enabled then execute the below commands to enable them:
) . . # su — lsmsadm
Note: Even if Query Serveris | §  dbcfginternal QUERY_SERVER Y
not c_onnected this step is Provide the “Customer Service ID”
required to take backup $ dbcfginternal RESYNCDB_QUERY_SERVER Y
Provide the “Customer Service ID”
$ exit
6. LSMS Active server: # Tsmsdb —c snapshot
[] | Backup the LSMS DB
WARNING: This command may cause a brief interruption in
traffic being sent from the NPAC to connected network
elements and local LSMS provisioning may be INTERRUPTED.
Do you want to continue? [Y/N]Y
Creating snapshot of the database partition, please wait...
File descriptor 5 (socket:[34104267]) leaked on lvcreate
invocation. Parent PID 28676: /usr/TKLC/1sms/tools/1smsdb
Logical volume "dbbackup" created
The database is available to the application again.
Disk snapshot created successfully.
Snapshot mounted successfully.
Created snapinfo.sql file successfully
MidAtlanticDB/
MidAtTanticDB/NumberPoolBTlock.frm
MidAtlanticDB/ServiceProvNetwork.MYD
Logica] volume "dbbackup" successfully removed
Note: The execution time of the above command shall vary according to the DB
size.
Verify that the following snapshot files are created at /var/TKLC/Isms/free
directory:
e mysql-snapshot-noreplDB.tar.gz
e mysgl-snapshot-supDB.tar.gz
e mysql-snapshot-<regionDB>.tar.gz
snapinfo.sqgl
7. LSMS Active server: . . .
. . Execute the following command and verify that the snapshot files are created for
] | Verify the snapshot files for

all existing NPAC regions

all the NPAC regions listed in the command output.
Note: The below command shows only the regions for which the DB exists.

# 1smsdb -c dblist
CanadaDB
MidAtTanticDB
MidwestDB
NortheastDB
Rep1TestDB
SoutheastDB
SouthwestDB
WestCoastDB
westernDB
TogDB

mysq1
norep1DB

performance_schema

supDB
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8. LSMS Active server: . i
0 Run the following command on LSMS Active server CLI to take MySQL dump
of the supDB database.
Take MySQL dump of supDB. | # mysqldump -udbroot -p[dbroot_password] supDB >
/var/TKLC/1sms/free/supbBdump.sql
Note: Take a note of EMS Note: Below warning mess%lge ca?] be 1'gnoge(_|j Gif displ ?cyed:
; ; warning: Using a password on the command Tine interface can
configuration (IP, user, Group) be insecure.
and delete the same on LSMS.
Note: Do not run the following command when upgrading from
14.0.0.X to 14.0.0.Y. This command is only required while
upgrading from 13.X release.
Edit supbBdump.sql to fix Authorization table
# sed -i 's/function/functions/g"' supbBdump.sql
> LSMS Active server: Create MySQLUserGrants.sql file listing all the users and their privileges usin
. ile listi u ir privi usi
L1 | Take MySQL dump of Y a J priviTed g

mysgl.user.

the following shell script MySQLUser.sh in the root directory:

File: MySQLUser.sh
MYSQL_CONN="-udbroot -ppassword"

mysql ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT('SHOW CREATE USER ''',user,'''@''',host,''';') FROM
mysqgl.user WHERE user<>'"" | sed "/mysql/d' | mysql
${MYSQL_CONN} --skip- column-names -A | sed 's/$/;/9' | sed
"s/IDENTIFIED WITH 'mysql_native_password' AS/IDENTIFIED
BY/g" | sed "s/IDENTIFIED WITH
'mysql_native_password'/IDENTIFIED BY/g" | sed "s/REQUIRE
NONE PASSWORD EXPIRE DEFAULT ACCOUNT

UNLOCK//g" > /var/TKLC/1sms/free/MySQLUserGrants.sql

mysql ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT( "SHOW GRANTS FOR ''',user,'''@''',host,''';') FROM
mysql.user WHERE user<>''" | mysql ${MYSQL_CONN} --skip-
column-names -A | sed 's/$/;/9' |sed 's/IDENTIFIED BY
PASSWORD/IDENTIFIED BY/g' | sed '/mysql/d' >>
/var/TKLC/Tsms/free/MySQLUserGrants.sql

Note: Edit MYSQL_CONN for the proper connection properties and this will
generate the MySQLUserGrants.sql file with grant statements from the 5.7
machine that you can source into the 8.0 machine.

Run the MySQLUser.sh file to generate MySQLUserGrants.sql

# chmod +x MySQLUser.sh
# ./MysQLUser.sh

Run command to edit MySQLUserGrants.sql
# sed -i 's/CREATE USER/CREATE USER IF NOT EXISTS/g'
MySQLUserGrants.sql

The content of the MySQLUserGrants.sqI will be:
GRANT USAGE ON *.* TO 'lsmsadm'@'%' IDENTIFIED BY
'57570851ac3cc01499';

Edit the .sql file and replace the password of all the users with plain text password

to contain something like:
GRANT USAGE ON *.* TO 'lsmsadm'@'%' IDENTIFIED BY 'password-
in-plain-text';

Run below commands to recover plain text password for default Isms users:
For dbroot user:




/usr/TKLC/Tsms/tools/pass_fetch
passl

For materepl user:

/usr/TKLC/Tsms/tools/pass_fetch pass3 -> materepl

For cmdline user:

/usr/TKLC/Tsms/tools/pass_fetch pass4 For other default
users:

/usr/TKLC/Tsms/tools/pass_fetch pass2
Remove entry for “Ismsrepl” @ <Ismsqgs IP>" from the
MySQLUserGrants.sql. This will be added during LSMSQS configuration.

Note: There is no way to reverse the hash to recover the plain text. So the
customer has to provide us the plain text passwords for users which were added
by customer.

Edit the MySQLUserGrants.sq] file and edit the second line:
CREATE USER IF NOT EXISTS 'dbnopriv'@'%'IDENTIFIED BY;
Here ‘’ are missing after IDENTIFIED BY ;

Example: CREATE USER IF NOT EXISTS ‘'dbnopriv'@'%'
IDENTIFIED BY ‘’;

For migration from 14.0.0.X to 14.0.0.Y edit the file
MysSQLUserGrants.sql

Remove below two lines in MySQLUserGrants.sql:

GRANT SELECT, INSERT, UPDATE, DELETE, CREATE, DROP,
RELOAD, SHUTDOWN, PROCESS, FILE, REFERENCES, INDEX, ALTER,
SHOW DATABASES, SUPER, CREATE TEMPORARY TABLES, LOCK
TABLES, EXECUTE, REPLICATION SLAVE, REPLICATION CLIENT,
CREATE VIEW, SHOW VIEW, CREATE ROUTINE, ALTER ROUTINE,
CREATE USER IF NOT EXISTS, EVENT, TRIGGER, CREATE
TABLESPACE, CREATE ROLE, DROP ROLE ON *.* TO dbroot @ %"
WITH GRANT OPTION;

GRANT
APPLICATION_PASSWORD_ADMIN,AUDIT_ABORT_EXEMPT,AUDIT_ADMIN,A
UTHENTICATION_POLICY_ADMIN, BACKUP_ADMIN,BINLOG_ADMIN,BINLOG
_ENCRYPTION_ADMIN, CLONE_ADMIN, CONNECTION_ADMIN, ENCRYPTION_K
EY_ADMIN, FIREWALL_EXEMPT, FLUSH_OPTIMIZER_COSTS, FLUSH_STATUS
y FLUSH_TABLES, FLUSH_USER_RESOURCES , GROUP_REPLICATION_ADMIN,
GROUP_REPLICATION_STREAM, INNODB_REDO_LOG_ARCHIVE, INNODB_RED
O_LOG_ENABLE, PASSWORDLESS_USER_ADMIN, PERSIST_RO_VARIABLES_A
DMIN, REPLICATION_APPLIER,REPLICATION_SLAVE_ADMIN,RESOURCE_G
ROUP_ADMIN, RESOURCE_GROUP_USER, ROLE_ADMIN, SENSITIVE_VARIABL
ES_OBSERVER, SERVICE_CONNECTION_ADMIN, SESSION_VARIABLES_ADMI
N, SET_USER_ID, SHOW_ROUTINE,SYSTEM_USER,SYSTEM_VARIABLES_ADM
IN, TABLE_ENCRYPTION_ADMIN, TELEMETRY_LOG_ADMIN, XA_RECOVER_AD
MIN ON *.* TO dbroot @ % WITH GRANT OPTION;

Add below line at the end of MySQLUserGrants.sql:

“GRANT ALL PRIVILEGES ON *.* TO 'dbroot'@'%' WITH
GRANT OPTION;”
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10. | LSMS Active server: Login to LSMS GUI as Ismsall user.
[] | Log intothe Active LSMS

server GUI
11. | LSMS Active server: 5o to “Admi MySOL P oo and dth fiaured MvSOL P
[] | Record the configured 0 to “Admin -> MySQL Port -> View” and record the configured MySQL Port.

MySQL Port
12| LSMS Active server: Go to “Confi LNP Syst EMS -> Vi d d the configured

. o0 to “Configure -> ystem -> -> View” and record the configure

] | Record the configured ELAP| =" \b <\ odentials.

Credentials
13. LSMS Active and Standby . . .
[ | Server Login to LSMS CLI and take back up of the below 2 files from both Active and

. Standby server:

Copy and Backup license /usr/TKLC/osi/conf/1icense

file when upgrading from /usr/local/netech/etc/license

LSMS 14.0.0.X release These licenses will be required after full upgrade is complete

This procedure is complete!

Procedure 7 TRANSFER DATABASE TO REMOTE SERVER

Procedure 7 - Transfer Database to Remote Server

? This procedure transfers the database backup from the LSMS server to the remote server.

E | Estimated time: 30 minutes

P

# | Note: 100mbps link is required for database transfer to remote server.

. ] Login: root

L LSMS Active server: Password: <root_password>

[] | Log in to the server as the
user “root”

2. LSMS Active server: # ping <remote IP> —c 3

[J'] Verify Connectivity PING <Remote IP> (<Remote IP>) 56(84) byt f dat

<Remote IP> (<Remote IP> ytes of data.
between the LSMS and the 64 bytes from <Remote IP>: icmp_seqg=1l ttl1=64 time=0.022 ms
remote server. 64 bytes from <Remote IP>: icmp_seq=2 tt1=64 time=0.020 ms
If the remote server cannot 64 bytes from <Remote IP>: icmp_seq=3 tt1=64 time=0.020 ms
be pinged, verify the --- <Remote IP> ping statistics ---
network connectivity. 3 packets transmitted, 3 received, 0% packet loss, time
2001ms




rtt min/avg/max/mdev = 0.020/0.020/0.022/0.005 ms

]| Copy snapshotfilesto a
Remote Server.

3. LSMS Active server: # 1s -1rt /var/TKLC/Isms/free/*snapshot*
[ ]| Listthe snapshot files # 1s -1rt /var/TKLC/1sms/free/supbBdump.sql
# 1s -1rt /var/TKLC/Tsms/free/MySQLUserGrants.sql
4. | Remote server: # rm /var/TKLC/1sms/free/mysql-snapshot-*
[] | Remove the existing DB # rm /var/TKLC/1sms/free/supDBdump.sql
snapshot files # rm /var/TKLC/Tsms/free/MysQLUserGrants.sql
5. LSMS Active server:

Transfer all the NPAC region DB snapshot files, the MySQL dump of supDB and
the MySQL dump of mysql.user

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,

NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
# scp -p /var/TKLC/1sms/free/mysql-snapshot-<NPAC
region>.tar.gz root@<Remote IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/Tsms/free/supDBdump.sql root@<Remote
IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/1sms/free/MySQLUserGrants.sql
root@<Remote IP>:<Remote IP Path>
Password: <root_password>

or
# cd /var/TKLC/1sms/free/

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computer>...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1list of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>

sftp> put mysql-snapshot-<NPAC region>.tar.gz
Uploading mysql-snapshot-<NPAC region>.tar.gz
sftp> put supbBdump.sql

Uploading supDBdump.sql

sftp> put MysQLUserGrants.sql

Uploading MySQLUserGrants.sql

sftp> bye

Remote Server:

[] | Verify the snapshot files are
present on the remote
server.

o

# 1s -Trt /var/TKLC/Tsms/free/*snapshot*
# 1s -1rt /var/TKLC/Tsms/free/supbBdump.sql
# 1s -1rt /var/TKLC/1sms/free/MySQLUserGrants.sql

This procedure is complete!

Full Upgrade for LSMS 14.0

14.0

030



3.5IPM and LSMS 14.0.X Installation
Procedure 8 IPM MPS SERVER WITH 64 BIT TPD 8.6.X

Procedure 8 - IPM MPS Server with 64 bit TPD 8.6.x

1. MPS X: Reboot server

Ol O | O | tnsert TPD 8.6.x # reboot

USB media into the
USB port

2 MPS X:

Press ‘del’ key to
enter the BIOS.
Enter System Time
and System Date.

3. MPS X:

Select Boot - Hard
Disk Drives option

* Hard Disk Drives

4 MPS X:

Press ‘Enter’ key
0| O and select USB as
the 1% Drive




5 MPS X:

Press ‘Esc’ key and
select Boot Device

1st Drive

{USE:SEART USB]

Prlorlty * Boot Device Priority
OO O
6. MPS X:
Verify that the 1%
Boot Device is set —_—
to USB. 1st Boot Device [USB:SHART USB]
0| O

21Qral d | mesx:
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3 s \
Press ‘Esc’ key and

H * Exit tions * Exit system setu »

SeIeCt EXIt 9 Save = ttrr:?’jv:xtt:xxtxx:f:xxf:xtt:xxnrx:txx:vtx:tt::rntx * after :avan thep *
Changes and Exit £ * changes. :
- * Discard Changes and Exit 2 'S
Optlon * Discard Changes * F10 key can be used *
= * for this operation. ]

* Load Optimal Defaults * *

* Load Failsafe Defaults X »

T * *

* * *

. . *

* * *

5 SN Select Screen =

E Lt Select Item x

¥ * Enter Go to Sub Screen *

* * F1 General Help *

= * F10 Save and Exit E

= * ESC  Exit *

* * *

* * *

AR A R R R AR SRR AR AR RS R R Rl Rl R RS iRt R L RS

Awerican ¥

MPS X:
Select [OK] to save

Hain P Boot ricy Chipset Exit
P R A R R R R R R R RN RN AR R RN RSIRERRRSRRSIRERSRRASRASROSRAS

the Configuraﬂon * Exit Options * Exit system setup '
T NIRRT IR IR R ARILRERL ISR RINSRR2RNLILEY % after Savlng the T
changes. : S 4
* Discard Changes and Exit * .
i * Discard Changes * F10 key can be used :
The server will ' * for this operation. *
T i PR ARSI AR ISR ERINCERSRERTLIRRANRERSIRSSSSZY t

reboot and TPD inacjopnimed 1)
. * Load Failsafe * L s
bOOt prompt WI“ ] * Save configuration changes and exit setup? ¥ 3
appearl * * * *
T AR R RS A RIS RASRRRRRRRRERER) 1
- & [Cancel] g
T LR R R R R R R R R R R R R R RS R SRR R t Screen 1]

T

b * Enter Go to Sub Screen *
* *F1 General Help ’
& * F10 Save and Exit i
: * ESC  Exic ¢
T * :
* * T

AR AN R A R N A R AN R R AN R AR T AR RN AN R AR AN AR R AN R AT RS RRT RN NIRRT AN

MPS X:

Start the IPM
process by entering
the TPDIvm
command at the
boot prompt.

ISOLINUX 6.04 Copyright (C) 1994-2015 H. Peter Anvin et al
boot: TPD1

MPS X:




After a few seconds,
additional messages
will begin scrolling
by on the screen as
the Linux kernel
boots, and then the
drive formatting and
file system creation
steps will begin.

TonTIguring SrCoTrags
Creating disklabel on /Jdewv/sdb

Creating mdmember on Jdewv/sdob2

Creating bioskboot on /dev/adbl

Creating disklabel on /sdewv/sdc

Creating mdmember on JSdev/sdc2

Creating lvmpv on /dewv/md/1l

Creating extd on /dev/mapper/vgroot—-plat_var_ tklc
Creating extd4d on /dev/mapper/vgroot—plat tmp
Creating extd4d on Jdev/mapper/vgroot—plat
Creating extd on /dev/mapper/vgroot—-plat
Creating swap on /dev/mapper/vgroot—-plat
Creating extd on sdev/mapper/vgroot—plat
Creating kbiosboot on /S/dev/sdcl

usr
var
=wap
root

Running pre-—-installation scripts
Running pre—installation tasks
Installing.

Starting package installation process
Downloading packages

1. MPS X:

Once the drive
formatting and file
system creation
steps are complete,
the screen at right
will appear
indicating that the
package installation
has begin.

1nscLali11ng cliding-resource—lrillesysLel.xso o4 (117071307

Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing

adwaita-cursor-theme.nocarch (1176/1507)
adwaita-icon-theme.nocarch (1177/1507)
gtk3.x86 64 (1178/1507)

gjs.xB86 64 (1179/1507)
adobe-mappings-pdf.ncarch (1180/1507)
libgs.x86 64 (1181/1507)
graphviz.x86_ 64 (1182/1507)
python3-pydot.nocarch (1183/1507)
python3-pygraphviz.xz86 64 (1184/1507)

Installing ghostscript.x86_ 64 (1185/1507)
Installing cups.x86 64 (1186/1507)

Installing cups-filters.x86 64 (1187/1507)
Installing python3-networkxz.noarch (1188/1507)
Installing gnome-characters.x86_64 (1189/1507)
Installing libcanberra-gtk3.x86_64 (1190/1507)
Installing libgnomekbd.x86 64 (1191/1507)
Installing libtimezonemap.x86 64 (1192/1507)
Installing firewalld.noarch (1193/1507)
Installing open-vm-tools.x86 64 (1194/1507)
Installing TPD-upgrade.ncarch (1195/1507)
anstalling TKLCebappb.nocarch (1196/1507)

12 MPS X:

Once all the
packages have been
successfully
installed, the screen
at right will appear
letting you know the

installation process
M| gupp is complete.

Remove USB
media before
Reboot.

MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Pulling ISO Metadata file from: /run/install/repo//.iscmetadata
Copying ISO metadata file to system
DIR: /mnt/sysimage/var/TKLC/log/ipm
Copying ISO metadata file to prodinfo
DIR: /mnt/sysimage/usr/TKLC/plat/etc/prodinfo
Changing default target to application.target
Revoke root ssh access
Installation complete

Use of this product is subject to the license agreement found at:
/usr/shareforaclelinux-release/EULA

Installation complete. Press ENTER to quit: I
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On MPS server
press<ENTER> to
reboot the system
and continue with
the next step.

13.

MPS X:

Press ‘del’ key to
enter the BIOS

System Time

14.

MPS X:

Select Boot > Hard
Disk Drives option

* Hard Disk Drives

15.

MPS X:




Press ‘Enter’ key
and select HDD:PO
as the 1% Drive

ist Drive

[HOD: PC-INTEL SSDSC)

16.

MPS X:
Press ‘Esc’ key and
select Boot Device
Priority

% Boot Device Priority

17.

MPS X:

Verify that the 1%
Boot Device is set
to HDD:PO.
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ist Boot Device

[HDD:PO-INTEL S5DSC])

18. MPS X:
Press ‘Esc’ key and
select Exit = Save
Ch?'nges and Exit Save Changes and Exit
option { 1 C B
19.

MPS X:

Select [OK] to save
the configuration
changes. The server
will reboot.




Nain Advanced PCIPnP Boot Security Chipset [Exit]
P T e e e T R e R e e S I R L T P T R T T T T

* Exit Options # Exit system setup ]
T IR NI RIS RN R ARSI INENINRNRINRY X after saving the *
* * changes. %
* Discard Changes and Exit il *
* Discard Changes # F10 key can be used 8
hd * for this operation. ]
T Load Optlmal DIII‘XI!'!!!"!!!lt!ttilt’tltt!tlitttltttit'tttitl z
* Load Failsafe * ' 8
. * Save configuration changes and exit setup? .
T T 1 =
T AARARA RS2SR ARRRAR AR RRRRRARARRRRRRRARRRRRRRAR R .
= - m [Cancel]) B s
T ARSAARARARARARARARERRRARRRARERRRRRARARARARARES N 14 screen .
T .
E * Enter Go to Sub Screen *
. v:FY General Help *
& * F10 Save and Exit .
* * ESC  Exit *
* ] 2
* L 4 t

L e e e ety

When the message ""Upstart Job ntdMgr: started™, is displayed, press the
Enter Key to get the Login prompt.

platform revision is
same as the ISO
used.

20. . : Oracle Linux Server 8.7
MPS X: Loginto : .
the server as the Kernel 4.18.0-477.27.0.1.e18 8.x86 64 on an x86_ 64
Lo user “root” localhost login: root
Password: [
21. MPS X: # getPlatRev
Verify that the 8.6.0.x.0-110.y.0

This procedure is complete!

Procedure 9

HFOMmM—-AW0m
>

PRE INSTALL CONFIGURATION

Procedure 9 — Pre-Install Configuration

This procedure will perform the initial configuration required for LSMS installation.
g | Estimated time: 15 minutes

Note: Below procedure needs to be executed on both MPS A and MPS B servers.

1. MPS X: Log in to Login: root
0 (g theserverasgthe user | Password: <root_password>
‘ﬁroot’9
2.

0 MPS X: Switch user
to platcfg.

# su - platcfg

Select “Server
Configuration” Menu

Full Upgrade for LSMS 14.0 14.0
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4| Main Menu |7

Maintenance
Diagnostics

ver Configuration

Remote Consoles
Hetwork Configuration

Security

Exit
MPS X:
Select “Hostname” 4 Server Configuration Menu F
Menu

Hostname
Designation/Function
Configure Storage
Set Clock

Time Zone

Exit

MPS X: Changethe | select Edit and press [ENTER]
host name.

1) Select “Edit” from — options |———

the options dialogue
box.

2) Set the hostname

4' Edit Hostname Ii

Ho=tname :

Select OK and press [ENTER].




Note: While connected to the serial console, some console output might come
when the user is using the serial console to configure the LSMS. Those serial

output are harmless and can be ignored.

5. . "

O d MPS X: Hostname Configuration
Verify that the
Hostname is correct
then select and press
“Exit”.

; Current Hostname: lsmsEpri
Otherwise repeat the L=n oSt nEm S|P
step above.

—| Cptions Ii

6. MPS X: Navigateto | select Designation/Function and press [ENTER]
the Designation

Information screen.
-I Server Configuration Menu |—

Configure Storage
Set Clock

Time Zone

Exit

O | O] MPsx:

1) Select “Edit”
from the options
dialogue box.

2) Set the
Designation as “1A”
on Server A and as
“1B” on Server B,
Function as “LSMS
and press “OK”.
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NOTE: ———] Edit Desigmation [——

De=zignation:

Designation and
Function:

Function should be
entered in
UPPERCASE.

MPS X: Designation Information
Verify that the
Designation and
Function is correct

then select and press
“Exit”. Function: LSMS

Designation: 1la

Otherwise repeatthe | T Speions ——

step above.
MPS X: Exit the Select Exit and press [ENTER] to return to the Main Menu.
platcfg menu Server Configuration Menu
NOTE: Hostname
DO NOT set the Designation/Function
time zone in platcfg. Configure Storage
Set Clock

The time zone will -
Time Zone

be set later in initial :
configurations.

Select Exit and press [ENTER]. The “platcfg” utility terminates.




—] Main Menu |—

Maintenance
Diagnostics

Server Configuration
Remote Consoles
Hetwork Configuration

This procedure is complete!

Procedure 10 CONFIGURE NETWORK INTERFACE USING PLATCFG UTILITY

Procedure 10 — Configure Network Interfaces using platcfg utility

Network

? This procedure configures the network interfaces and makes the ESAPPB servers accessible to the network.
E | B | Estimated time: 5 minutes
2}
#
. Console Login: root
L| O mpsx: Password: <root_password>
Login as root
user.
> | OOl mes x: # su - platcfg
Login to
platcfg utility
3| O] mpPsx: lgggggqu Main Menu tgggggggk
Confi B .
Nonlgﬂe ¥ Maintenance %
etwor ¥ Diagnostics a
Interface ¥ Server Configuration a
x Remote Consoles a x
¥ Security %
£ ork C b4
4 it
4 =

ngaggggagaagagagaaaaaaaaaaad
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lu Network Configuration Menu tk

o]

Network Interfaces
SNMP Configuration
Routing

Configure Network
Network Bridges
CHRONY

Iptables

Resolv

IPSEC Configuration

Stunnel
Modify Hosts File
Exit

U U Y VI VI R D

e T T T T

nggggaggagagdaagaagadaaaaaaaaaaad
lu Network Interfaces Menu tk

e A A

Add an Interface

Edit an Interface
Delete an Interface
Restart an Interface
Exit

a
a

T

e B A A L

nhaectdion

bond0
bond0. 2

ethl
eth2
eth3
Exit

to edit Menu

L]

ngggqqq9qqa9qq9Iqqqaqgqaqqaqqqq]

—I Options |7




a.| L] mpsx:
Select lgggggggqu Interface Options tggggggagk

Interface vro: [

Options
GRO:

GSO:

hwaddr:
BootProto:

1gggggqggk
. Cancel x

Mg

mqqqq]

T B T T T A A A
T T T T T O O O

MO O T O O R O T Y Oy CT O O O T O T O O CT T O CY T O O CT IOy Ty
————————————4 Configure Ethtool Options F—————————————

Would wou like to configure Ethtool Options?

I Configure IP Address I

Would you like to configure IP addresses?

4 Choose IP Address Version Menu

IFvE
Exit
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———————1 Chooze IPv4 Address Action f————————

Choose Address Action:

MPS X:
Input the IF LRddress:
Interface Hetmask:
Address Start on Boot:

Liwve:

I Message I
Interface Edited
Press any kewy to continue. ..
Select “Exit” until you exit from the platcfg utility.

MPS X: -4 MNetwork Configuration Menu F
Conﬂmﬂe SMMP Configuration

default route.

Network Interfaces
Network Bridges
Configure MNetwork
Fouting

MNTF

Iptables

IPSEC Configuration
Resolw

Stunnel

Modify Host=s File
Configure Jwitch
Exit
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1 Add default Route ggggggggk
B %
s Device: < > bondO %
£ < > bond0.2 ¥
B <o> ethl %
B < > ethl %
s < > eth?2 %
£ < > eth3 ¥
% Gateway: 10.250.50.1 X
B %
= [@4 Cancel )
5 3
mqqqqqqqqqqqqqqqqqqqqqqqqqqqjw
cC

Select “Exit” until you exit from the platcfg utility.

Procedure 11 INSTALL THE LSMS APPLICATION

Procedure 11 - Install the LSMS Application

This procedure installs the application on the server.
Estimated time: 25 minutes

Note : Below procedure needs to be executed on both MPS A and MPS B servers.

Pl om4aow

MPS X: Log in to Console Login: root
L1 | O | console the serveras | Password: <root_password>

the user “root”

MPS X: Perform
0 4 Procedure in 3.7A.1
or copy LSMS
14.0.X1SO to
Ivar/TKLC/upgrade
directory.

MPS X: Start # su - platcfg
0| O platcfg utility by
logging in as platcfgy
user.

MPS X: Early The platcfg Main Menu appears.

O O
upgrade checks On the “Main Menu”, select Maintenance and press [ENTER].




|
lggggggu Main Menu tggggggqk

Maintenance
Diagnostics
Server Configuration
Network Configuration
Remote Consoles
Security

Exit

EEEIEIEIEEEEEEE
T TR TR T]
e T T T T T T

moggaggaagaaaaaaaaaaaaaagaa

Select the “Upgrade” menu and press [ENTER].

lggggu Maintenance Menu tgggggk

Dual Image Upgrade

Upgrade

Patching
Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Platform Data Collector

Exit

Ju1]

T T T T T

P L L B B T A
A ¥ ¥ R P ]

mgg999qq49999I9I9q9I999999999999997

Select the “Early Upgrade Checks” menu to verify that the system is ready for
upgrade.

lggggggqu Upgrade Menu tggggqgggk
)34 =
2 Validate Media %
vllFarly Upgrade Checks a =
% Initiate Upgrade %
 Copy USB Upgrade Image a x
x Non Tekelec RPM Management a x
2 Accept Upgrade a =
% Reject Upgrade a =
x Exit X
® X
ule(sle(ofe(s(o(e(e(ole(e(ole(e(olo(e (oo (e (o (o (e (el e (sl e (e ]

Select the desired upgrade media and press [ENTER].

1lggagqqaaaqagaqdaadadqau Choose Upgrade Media Menu tqggaaqaaadaadqadaadak

[ x|
pell.SMS—-14.0.0.0.0 140.6.5 6 64.is0 - 14.0.0.0.0 140.6.5 ]
x Exit b4
[ |

mggqqqq999999999999999999999999999939999999999999999999999999IIIITIIIT ]
If the Early Upgrade Checks fail due to the ongoing syncing of raid mirrors, then
follow the steps 5 and 6 to ignore the disk mirroring before the LSMS installation. If
the Early Upgrade Checks passed then jump to Step 7.
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Early Checks failed for the next upgrade

Look at earlyChecks.logy for wmore info

tarting Early Upgrade Checks at 1011413059

Funning earlyUpgradeChecks () for Upgrade::EarlyPolicy: :TPDEarlyChecks upgrade policy...
Werified serwver is not pending accept of previous upgrade

ERROR: RBaid mirrors are synoing!

ERROR: mdZ is syncing!

ERROR: earlyUpgradeChecks () code failed for Upgrade::EarlyPolicy::TPDEarlyChecks
ERROR: Failed running earlyUpgradeChecks() code

Hardware architectures match

Install products match.

No Application installed wet.. Skip alarm check!

ERROR: Early Upgrade Checks Failed!

Uszer has regquested just to run early checks.

No upgrade will be performed...

Early Upgrade Checks finished at 1011413059

[admusrlepappri ~]1§ cat /proc/mdstat

Personalities @ [raidl]

mdl @ active raidl sdh2[1] =sdal[0]
262080 blocks super 1.0 [2/2] [UD]

md2 @ active raidl sdal[0] sdbil[1]
465447232 blocks super 1.1 [2/2] [UU]
[=====F i ennannss ] resynz = 29.7% (139377920/468447232) finish=73.0min speed=75060K/sec
hitmap: 4/4 pages [16EB], 65536KE chunk

unused devices: <nonex

Contact My Oracle Support following the instructions on the Appendix E, if the early
upgrade checks fail due to any other reason.

MPS X: Exit the
platcfg menu

Select Exit and press [ENTER] to return to the Maintenance Menu.

1qggqqgaqqaqqqaqaqqgqqu Choose Upgrade Media Menu tqggaqqagqqqgqaqqaqqqdak

3 b4
< LSMS-14.0.0.0.0 140.6.5-x86 64.is0 - 14.0.0.0.0 140.6.5 o
< 3
X X

[ngoggggggqogaggqgqaqaaaqaqaqaqaqqqa9qaq9q99qa9q9999999999999999999999999]

lggggggqu Upgrade Menu tggggggggk

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USB Upgrade Image
Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

AR N P P

EEEEEEEEE

P4
P4
P4
P4
P4
P4
b4
4
4
4

Mg gqaggagaqdadaqaqdadqaqaaaaadadd

Select Exit and press [ENTER] to return to the Main Menu.




lggggu Maintenance Menu tgggggk

Dual Image Upgrade
Upgrade

Patching

Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Platform Data Collector

AT ¥ ¥ ¥ T
e T T T T T

P R I I A

ngggqqqqIqIqaqgIqIqaqaqIgIqaqIqIqqdd

Select Exit and press [ENTER]. The “platcfg” utility terminates.
lgggggqu Main Menu tqggggggk
)4 X
% Maintenance X
% Diagnostics a x
% Server Configuration a
® Network Configuration a x
¥ Remote Consoles a x
¥ Security X
I X
I X
ils(e(e(s(e(e(e(e(s(o(e(e(s(e(o(e(s(e(o(e e(e (e (o (e (e

6. MPS X: Ignore disk

OO mirroring before # echo "IGNORE_EARLY_CHECKS=1" >
LSMS installation | /var/TKLC/Tog/upgrade/tmp_upgrade.conf

verify:
# cat /var/TKLC/Tog/upgrade/tmp_upgrade.conf
IGNORE_EARLY_CHECKS=1

7. MPS X: Validate On the platcfg “Main Menu”, select Maintenance and press [ENTER].
the upgrade media

lggggggu Main Menu tgggggddak

= =

plMaintenance =

Use the “Arrow” % Diagnostics b4
and the [ENTER] % Server Configuration a x|
: x Network Configuration a x|

keys to na_wgate the x Remote Consoles a =
Menu options as x Security a ¥
shown to choose the | [ Exit b4
5z x|

upgrade media. :
itilefelelelsloiele (olole ol (ool s (oo oo (ol (o)
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Press any key to
return to the menu
and then press Exit
all way back to the
Maintenance Menu

lggggu Maintenance Menu tgggggk

Dual Image Upgrade

1

Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Platform Data Collector
Exit

e I A A R
L
MO D X

ilsfaiea aiea(a(aia(e(aia(e(a(a(=(a(a(a(a(=(a (s a o (a o

laggggqaau Upgrade Menu tgggggaagk

Early Upgrade Checks
Initiate Upgrade

Copy USB Upgrade Image
Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

Exit

KoM oM MMM MM KN
UV T T
X oMWW OM MMM XN

magqggaaaaaa99aa9I9a99999999999999 ]

lagqaggqqaqqagqqqqqqu Choose Upgrade Media Menu tggggggqdqqaqadqdadaddqaqak

gq9999999999999999999999999999999999999999999999IIIIIIIIIIIIIIIITIIT]

The results of the validation will be displayed, similar to the
example below.

Press the “enter” key to continue.




I E Iy I I I I I I I I I I IIITIIIIITIEIII]
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
FhEFEF A F SRR ARSI AR SRR R AR R AR SRR AR R R SRR RS
FhEEFEFEF A SRR AF SRR AR ES A E R AR ERE A AR AR SRR AR SRR RS S
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
FhEFEF A F SRR ARSI AR SRR R AR R AR SRR AR R R SRR RS
FhEEFEFEF A SRR AF SRR AR ES A E R AR ERE A AR AR SRR AR SRR RS S
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
FhEFEF A F SRR ARSI AR SRR R AR R AR SRR AR R R SRR RS
FhEEFEFEF A SRR AF SRR AR ES A E R AR ERE A AR AR SRR AR SRR RS S
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
FhEFEF A F SRR ARSI AR SRR R AR R AR SRR AR R R SRR RS
FhEEFEFEF A SRR AF SRR AR ES A E R AR ERE A AR AR SRR AR SRR RS S
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
FhEFEF A F SRR ARSI AR SRR R AR R AR SRR AR R R SRR RS
FhEEFEFEF A SRR AF SRR AR ES A E R AR ERE A AR AR SRR AR SRR RS S
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
FhEFEF A F SRR ARSI AR SRR R AR R AR SRR AR R R SRR RS
FhEEFEFEF A SRR AF SRR AR ES A E R AR ERE A AR AR SRR AR SRR RS S
Hh#d4FAE A F A AR AR R AR AR AR AR AR R R AR R R R R
(s SR s s itz i st st s i s s it it st sl
(s E s PR s sttt st

JMVT Validate Utility v2.3.4, (c)Tekelec, May 2014
vValidating /var/TKLC/upgrade/LSM5-14.0.0.0.0_140.6.5-x86_¢t4.is0
Date&Time: 2023-12-16 06:37:36

volume ID: 14.0.0.0.0 140.6.5

Part Number: N/A

Version: 14.0.0.0.0_140.6.5

Disc Label: LSMS

Disc description: LSMS

The media validation is complete, the result is: PASS

CDROM is Valid

PRESS ANY KEY TO RETURN TO THE PLATCFG MENU.

8. MPS X: Navigate to
CJ| CJ| the initiate Upgrade
menu.

Use the “Arrow”
and the [ENTER]
keys to navigate the
Menu options as
shown to choose the
upgrade media.

Select the Initiate Upgrade menu and press [ENTER].

lggggggqu Upgrade Menu tggggggggk

Validate Media
Early Upgrade Checks
Initiate Ur de
Copy USB Upgrade Image
Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

Exit

w

L T R
TR D T ]
T T R L

Wkl EEEEEEEEEEEEEEEEEEEEEEEE

The screen displays a message that it is searching for upgrade media. When the
upgrade media is found, an Upgrade Media selection menu appears similar to the
example below.

Select the desired upgrade media and press [ENTER].
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1lggagqqgaqqaaqqaadqagu Choose Upgrade Media Menu tgqggaaqaaqdaaaqaaqdaly

[ ]
el SMS—14.0.0.0.0 140.6. 5 64.is0 - 14.0.0.0.0 140.6.5 ¥]
x Exit b4
32 b4

le(e(s[efs[=[e(e(s (o (s o] ={e(s(s (o(s [o]s (=(e(s{s o] [={e(a{s o{s [o[s (={e[s(s [o{s [o[s = (e [s{s [ofs (o[e[a(s [o{s (s (=(e[s{s [o]s (o[e (== (o

The screen displays the output like following, indicating that the upgrade software is

MPS X:
Upgrade proceeds first running the upgrade checks, and then proceeding with the upgrade.
HNo Application installed yet.. Skip alarm check!
WVerified all raid mirrors are synced.
Early Upgrade Checks Hawve Passed!
Farly Upgrade Checks finished at 1447429031
Enitializing upgrade information...
Many informational messages appear on the terminal screen as the upgrade proceeds.
The messages are not shown here for clarity sake. When installation is complete, the
server reboots.
10. MPS X: Upgrade After the final reboot, the screen displays the login prompt as in the example below.
completed
1462266947: Upstart Job TKL Csnmp-subagent: started
B e e e =3
1462266947: Upstart Job syscheck: started
B e e e =3
1462266947 Upstart Job tpdProvd: started
B e e e =3
1462266949: Upstart Job ntdMgr: started
B e e =3
Oracle Linux Server release 6.7
Kemel 2.6.32-573.18.1.el6prerel7.0.3.0.0 86.44.0.x86 64 on an xX86 64
Ismspri login:
11. . Login: root
“APS)L Password: <root_password>
Login as root user.
12. MPS X : # grep -i error /var/TKLC/log/upgrade/upgrade.log
1724760824 : :ERROR: Command returned non-zero exit code 256
Check the upgrade (systemctl start TKLCpldhcp)

and warnings

# grep -i error /var/TKLC/log/upgrade/ugwrap.log

# grep -i warning /var/TKLC/log/upgrade/upgrade.log
1724760624 : :WARNING: TKLClsms-Config-2.0.4-14.0.0.1.0_140.9.0:
Current hostname "Steak-B" being reset to default.

1724760681: : TKLC1sms warning: user %{root}
does not exist - using root

1724760681: :warning: group %{root} does not exist - using root
1724760759: :WARNING: Could not dup STDERR to STDOUT: Bad file
descriptor

1724760971: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1724760971: :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/TsmsAlarms.xm]l

#

# grep "Upgrade returned success"
/var/TKLC/Tog/upgrade/upgrade.log




1248284646:: Upgrade returned success!

# grep -i error /var/TKLC/Tlog/upgrade/upgrade.log

only below error is expected

1512594958: :ERROR: Command returned non-zero exit code 768
(/sbin/service TKLCpldhcp start)

# grep -1i error /var/TKLC/Tlog/upgrade/ugwrap.log
There should be no error output.

# grep -i warning /var/TKLC/log/upgrade/upgrade.log
The following warning are expected:

The following warning are expected:

1512594173: :WARNING: /usr/TKLC/plat/etc/alarms/alarms.xml has
been updated...reparsing xml...

1512594265: :warning: erase unlink of /etc/ssm/hwmgmtd.conf
failed: No such file or directory
1512594267: : kexec-tools #warning:

/etc/kdump.conf created as /etc/kdump.conf.rpmnew

1512594414: :setup
HHAHBRBRBHHHHHH R AAA R HHH R AR warning
/etc/shadow created as /etc/shadow.rpmnew

1512594430: :ca-certificates HHHHHE R #warning
/etc/pki/tls/certs/ca-bundle.crt created as
/etc/pki/tls/certs/ca-bundle.crt.rpmnew

1512594464: :warning: user mysql does not exist - using root
1512594464 : :warning: group mysql does not exist - using root
1512594464: :warning: user mysql does not exist - using root
1512594464: :warning: group mysql does not exist - using root

1512594464::2017-12-06 16:07:44 0 [warning] TIMESTAMP with
implicit DEFAULT value is deprecated. Please use --
explicit_defaults_for_timestamp server option (see documentation
for more details).

1512594465::2017-12-06 16:07:44 14331 [warning] InnoDB: New log
files created, LSN=45781

1512594465::2017-12-06 16:07:44 14331 [warning] InnoDB: Creating
foreign key constraint system tables.

1512594467::2017-12-06 16:07:46 0 [wWarning] TIMESTAMP with
implicit DEFAULT value is deprecated. Please use --
explicit_defaults_for_timestamp server option (see documentation
for more details).

1512594468: :WARNING: Default config file /etc/my.cnf exists on
the system

1512594469: : samhain warning: /etc/samhainrc
created as /etc/samhainrc.rpmnew

1512594473 : php-common #warning: /etc/php.ini
created as /etc/php.ini.rpmnew

1512594551 :initscripts ##warning:
/etc/sysctl.conf created as /etc/sysctl.conf.rpmnew

1512594603: :ntp warning: /etc/ntp.conf
created as /etc/ntp.conf.rpmnew

1512594615: : TKLCplat ###### SR #warning

/usr/TKLC/plat/etc/pid_conf created as
/usr/TKLC/plat/etc/pid_conf.rpmnew
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1512594615: :#warning: /usr/TKLC/plat/etc/service_conf created as
/usr/TKLC/plat/etc/service_conf.rpmnew

1512594630: : TKLCalarms ###warning:
/usr/TKLC/plat/etc/alarms/alarms.xml saved as
/usr/TKLC/plat/etc/alarms/alarms.xml.rpmsave

1512594637::alarmMgr ###warning:
/usr/TKLC/plat/etc/alarmMmgr/alarmMgr.conf created as
/usr/TKLC/plat/etc/alarmmgr/alarmmgr. conf. rpmnew

1512594770: :WARNING: This capability is not defined in the
default capabilities.

1512594770: :WARNING: Nor is it defined in the current hardware
ID's capabilities.

1512594770 :WARNING: CAPABILITY: service_disabled
1512594770: :WARNING: HARDWARE ID: ESAPPB

1512594885: : sudo warning: /etc/sudoers
created as /etc/sudoers.rpmnew

1512594922 :WARNING: TKLClsms-Config-1.4.9-13.2.1.0.0_132.22.0:
current hostname "lsmspri" being reset to default.

1512594923: :WARNING: Hostname not changed because it is the
same.

1512594966: :WARNING: Could not write to config file /usr/my-
new.cnf: Permission denied

1512594966: :Installing MySQL system tables...2017-12-06 16:16:06
0 [warning] 'THREAD_CONCURRENCY' is deprecated and will be
removed in a future release.

1512594966::2017-12-06 16:16:06 31217 [warning] The option
innodb (skip-innodb) 1is deprecated and will be removed in a
future release

1512594966::Filling help tables...2017-12-06 16:16:06 0
[warning] 'THREAD_CONCURRENCY' is deprecated and will be removed
in a future release.

1512594966::2017-12-06 16:16:06 31220 [warning] The option
innodb (skip-innodb) 1is deprecated and will be removed in a
future release

1512594966: :WARNING: Could not copy config file template
/usr/share/mysql/my-default.cnf to

1512594966: :WARNING: Default config file /etc/my.cnf exists on
the system

1512594972: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1512594972 : :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/1smsAlarms.xml

1512594974 : :WARNING: Module variable EXPECTED_CPUS is
deprecated!

1512594975 :WARNING: CONFIG:
/usr/TKLC/plat/1ib/Syscheck/modules/system/cpu/config

1512594975 :WARNING: Module variable EXPECTED_CPU_ALM is
deprecated!

1512594975 :WARNING: CONFIG:
/usr/TKLC/plat/1ib/Syscheck/modules/system/cpu/config

1702719042 : :WARNING: TKLClsms-Config-2.0.3-0.70555: Current
hostname "1smspri" being reset to default.




1702719098: : TKLCIsms
HHHHHHHHHHH T #####warning . user %{root} does not
exist - using root

1702719104: :warning: group %{root} does not exist - using root

1702719175: :WARNING: Could not dup STDERR to STDOUT: Bad file
descriptor

1702719391: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1702719391 : :WARNING: FILE:
/usr/TKLC/pTlat/etc/alarms/1smsAlarms.xml

13.

MPS X:

Verify LSMS
release.

# rpm -qi TKLClsms

14

Create config file in
ssh directory :

Do not run this if
ELAP is already
upgraded to ELAP11

Run below steps on both servers after installation is complete:

1. switch to Ismsadm user
2. cd.ssh
3. Create a config file using *vi config* in the /var/TKLC/Isms/Ismsadm/.ssh with
below content
Host *
HostKeyAlgorithms +ssh-rsa
PubkeyAcceptedKeyTypes +ssh-rsa
Note:- Default permission and ownership will automatically be added to this file
for Ismsadm user
4. Switch back to root user
. Add ssh-rsa at the end of the line:
For example:
HostKeyAlgorithms ssh-ed25519,ssh-ed25519-cert-
v0l@openssh.com,ecdsa-sha2-nistp384,ecdsa-sha2-
nistp384-cert-v0l@openssh.com,rsa-sha2-512,rsa-sha2-
512-cert-v0l@openssh.com,rsa-sha2-256,rsa-sha2-256-
cert-v0l@openssh.com,ecdsa-sha2-nistp256,ecdsa-sha2-
nistp256-cert-v0l@openssh.com,ecdsa-sha2-
nistp521,ecdsa-sha2-nistp521l-cert-
v0l@openssh.com,ssh-rsa
6. Restart sshd service using the below command:
systemct] restart sshd
7. Perform steps 1-6 on mate server.

(9]

This procedure is complete!

3.61Initial Configuration

Procedure 12 LSMS INITIAL CONFIGURATION
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Procedure 12 - LSMS Initial Configuration

This procedure does the initial configuration on the LSMS servers.

Estimated time: 15 minutes

DE—‘ #+OmMm—Ww

MPS A: Log in to the server as the
user “root”.

Login: root
Password: <root_password>

I:lP

MPS A:
Start Ismsmgr utility by logging in as
Ismsmgr user

# su - Tsmsmgr

I:lP’

MPS A:

Select “Initial Configuration”

——— Main Menu |——

Maintenance
Diagnostics

Server Configuration
Hetwork Configuration
Exit

DP

MPS A:

Select “yes”

Select OK and press [ENTER]

—] Select running options |—

i

MPS A:

Enter password for “root”

Select OK and press [ENTER]

- Query for FirstTimeConfig::010KeyExchange |

Enter root password: _

°

MPS A:

Enter password for “Ismsadm” Select
OK and press [ENTER]

- Query for FirstTimeConfig::0lZ2AdmKeyvExchange |

Enter lsmsadm password: _




N

MPS A: —| fuery for FiratTimeConfig::01l3RootAdmUsrEevExchange |—

Enter admusr password: _

Enter password for “admusr” Select
OK and press [ENTER]
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MPS A:

Enter the NAS password used to
login into NAS console. Accept the
default serial port (ttyS2) when
prompted for the path to the NAS
console device.

Select OK and press [ENTER]

——————————— Query for FirstTimeConfig::05BackupConfig —————

Enter the NAS root password for MAS configuration:: _
Enter path to NAS console dewice:: [N

[1°

A message is displayed indicating the root Key Exchange was successful.

A message is displayed indicating the Ismsadm Key Exchange was successful.

A message is displayed indicating the admusr Key Exchange was successful.

A message is displayed indicating the Time Synchronization was successful.

A message is displayed indicating the Database creation was successful.

A message is displayed indicating the NAS Backup Configuration was successful.

A message is displayed indicating the inhibiting of the node was successful.

Select Exit and press [ENTER] repeatedly to exit Ismsmgr

10.| MPS A: #ssh mate
LJ| switch to mate
11.| MPS B: # su - lsmsmgr
[
Start Ismsmgr
12.| MPS B: ——] Main Menu |—
[
Maintenance
. . Diagno=stics
Select “Initial Configuration” . .
Server Configuration
Hetwork Configurationm
Exit
13.| MPS B: —| Select running options |—
[
Select “yes”
Select OK and press [ENTER]
14. MPS B QuUecy for Firsciimecontig::OSBackupContag
|:| Enter the NMAS root pasaword for NAS configuracion:: [IIINENEGEN

Enter the NAS password used to
login into NAS console.




Select OK and press [ENTER]

15. [ A message is displayed indicating the Database creation was successful.
A message is displayed indicating the NAS Backup Configuration was successful.

Select Exit and press [ENTER] repeatedly to exit Ismsmgr

card.

16.| MPS B: # minicom mate
O Log into the LSMS B server via
minicom.
17. MPS A: #init6
Ll perform init 6 to reboot the LSMS B
card. Watch for errors during boot process.
When the login prompt is displayed, exit from minicom.
18.| MPS A: # minicom mate
O Log into the LSMS A server via
minicom.
19.| MPS B: # 1nit 6

L] Perform init 6 to reboot the LSMS A | Watch for errors during boot process.

When the login prompt is displayed, exit from minicom.

This procedure is complete!

Procedure 13CONFIGURE TIME ZONE AND CLOCK

Procedure 13 — Configure Time Zone and Clock.

S | This procedure configures the time zone and clock.
E Estimated time: 5 minutes
z Note: Below procedure needs to be executed on both MPS A and B servers.
L | MPSX: Logintothe | Login: root d
[ | server as the user Password: <root_password>
“root”.
MPS X: Start # su - lsmsmgr
2 Ismsmgr utility by
O logging in as
Ismsmgr user.
MPS X:: Verify time | Select Server Configuration and press [ENTER].
3| zone.
0
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—— Main Menu [—

Initial Configuration
Maintenance
Diagnostics

Exit

Select Time Zone and press [ENTER].

- Server Configuration Menu |

Set Clock

Exit

The screen shows the current time zone setting.

=x
1 ggggaglk

uifafeels (s (s{eegs(s(s (s{s{s{s(s (a(s (r{e i)

If this is not correct, select Edit and press [ENTER].

If the time zone is correct, select Exit, press [ENTER] and skip the next step

DP

MPS X: Change time
zone.

Select appropriate time zone and press [ENTER].




lggggggu Select Time Zone Menu tggggggk

MOoMOBMoOM oMM oM oMM OMOMOM MM MMM MM

e (s (a o oo (o (o oo (o (o o (o (o o o o o o o (o o o o o o s o o L (0 s

Emerica/Mazatlan
Emerica/Mendoza
Emerica/Menominee
Emerica/Merida
Emerica/Metlakatla
America/Mexico City
America/Miquelon
Emerica/Moncton
America/Monterrey
Emerica/Montevideo
Emerica/Montreal
Emerica/Mont=serrat
Emerica/Nassau

a/New York
America/Nipigon
Emerica/Nome
Emerica/Noronha

oo

oo
BOoM M OE oMM oMM MMM OMOMOH MM OMH KK

Select Yes to set the hardware clock to GMT and press [ENTER].

=

WH R EHEHER

S5et hardware clock to GHMT?

1 gogaak]
g Yes |

mggqaa;

logggogagagadagaqu Time Zone tggaaggdadaadk

1gogak
< HNo x
mgaqgq]

ixils fu fo o (o (o o o {n o (o o (o o o o s o o o i o o s o o o o ]

MPS X: Set clock.

ks

Select Set Clock and press [ENTER].

Server Configuration Menu

Select Edit and press [ENTER].

Options
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Enter correct time.
—| Change Date and Time |—

Date:
Time:

Use right arrow to get to OK and press [ENTER].

e

MPS X: Exit the
Ismsmgr menu

Select Exit and press [ENTER] to return to the Main Menu.
Server Configuration Menu F

S5et Clock
Time Zone

Select Exit and press [ENTER]. The “Ismsmgr” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagnostics

Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 14 SINGLE SUBNET CONFIGURATION FOR LSMS MPS CARDS

Procedure 14 - Single Subnet Configuration for LSMS MPS Cards.

“root”.

S | This procedure configures the system as single subnet at the customer site.
E Estimated time: 10 minutes
; NOTE: All the information should be taken before starting upgrade as part of Section 1.6
MPS A: Logintothe | Login: root g
1|.:| server as the user Password: <root_password>




MPS A: Start # su - lsmsmgr
2_ | Ismsmgr utility as
O Ismsmgr user.

MPS A: Change the | Select Network Configuration and press [ENTER].
3|":| network configuration

—{ Main Menu |——

Initial Configuration

Haintenance E
Diagnostics E
Server Configuration
Metwork Configuration E
Exit

Select Network Reconfiguration and press [ENTER].

_I

Metwork Configuration Menu |

MHetwork Reconfigurati
SHMP Configuration
Routing

HIP

IPSEC Configuration
Modify Hosts File

Exit

Select Yes to proceed to Network configuration.
lgggggggdadgdyagagqgu Network Reconfiguration tgggdogaqyagadadadadgk

-4

R

WARNING: Thi=s action is service impacting. Are you sure?

1agggkll ggggglk

ma g

mggagg]

nOOoIIIIaaIIIIIIIIIIIoOOIIIIoaooIIqaqaaIIIIooaadIIoqaIIoaoooaaaaaaoo
A lynx driven screen will appear with the following prompt;

Do you want to execute "/usr/TKLC/Isms/tools/IsmsnetAdm-bin/Ismsnetadm.cgi*?

Type “Y/y” to continue and the next screen will appear and press the right arrow key to

follow the link

Select Single from the Subnet Type menu and then select Continue.
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Continue

l:]tp

MPS A: Enter
network values.

Using the up and down arrows, scroll through the text fields, entering the desired values ( to
enter the netmask, highlight the field and then use the enter key or right arrow key to
display the dropdown menu, choose the desired value from the list) for each fields:

e:lsmspri

y: 192.168
' 192.168.59.30 3kt [255.255.255.0_ ]

IF: 192.168.59.31

Netmask: [255.255.255.0 ]

': 192.168.59.32

ite IP: 192.168.59.250

r: 10.250.32.10

Start Over

Once the values are entered press the down arrow to select the “Submit” button and press
the right arrow to follow the link.

Note: The System Number shall be as follows:
o LEYYWWMMXX
o Where:
o LEisthe new System Number Prefix for LSMS.
oYY = YEAR - year of the system shipment
o WW=WEEK - calendar week of the Y'Y year when the system is
shipped
o MM =MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle
o XX =number in line of systems shipped that week




MPS A: Apply If the values pass a sanity test for validity, then the “Confirm” button will be visible. Use
network settings the down arrow to select “Confirm” and press the right arrow to apply the changes. If the
sanity tests failed, the reasons will be stated. Use the left arrow key to go back to the edit

screen.

The execution could take a few minutes, be patient. The screen will eventually report the
status of the completion. If an error occurs, contact My Oracle Support following the
instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.

L3NS Net Admin
EM NUN LE11111111
TYPE single

forming remote configuration...
forming local configuration...

e utiltity (press 'g'

Use arrow keys to move, ? nelp q' T - < to go b
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MPS A: Exitthe Select Exit and press [ENTER] to return to the Main Menu.
Ismsmgr menu | Network Configuration Menu |

Hetwork Reconfiguration
SHMP Configuration
Routing

HTP

IPSEC Comfiguration

Select Exit and press [ENTER]. The “platcfg” utility terminates.

Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 15 SEGMENTED CONFIGURATION FOR LSMS CARDS

Procedure 15 - Segmented Configuration for MPS LSMS Cards

This procedure configures the system as segmented subnet at the customer site.

Estimated time: 10 minutes

NOTE: All the information should be taken before starting upgrade as part of Section 1.6

|:| P ##omaw

MPS A: Log in to the server
as the user “root”.

Login: root
Password: <root_password>

e

MPS A: Start Ismsmgr
utility by login as Ismsmgr
user

# su - Tsmsmgr

w

MPS A: Change the
network configuration

Select Network Configuration and press [ENTER].




— Main Menu |——

Initial Configuration

Maintenance B
Diagnostics B
Server Configuration

Hetwork Configuration E

Exit

Select Network Reconfiguration and press [ENTER].

-| Hetwork Configuration Memnu |

Metwork Reconfiguration
SHMP Configuration
Routing

NTP

IPSEC Configuration
Modify Hosts File

Exit

Select Yes to proceed to Network configuration.

Loggoggagggggggaaggggdgau Network Reconfiguration tgoaoaaaaaaaaaaaaad
x

WAENING: Thi=s action is service impacting. Are vou sure?

x Mo x xlﬂﬁ'}
moqag] mgogog;

MoM oM oMM MR

mOaaaaoooaaooooooodaaaaaaaaaaaaaaaaaoaooooaaaaaaaaaaaaaaaaaaagaaad
A lynx driven screen will appear with the following prompt;

Do you want to execute "//usr/TKLC/Isms/tools/IsmsnetAdm-
bin/Ismsnetadm.cgi"?

Type “Y/y” to continue and the next screen will appear and press the right arrow
key to follow the link

Select Segmented from the Subnet Type menu and then select Continue.

will cause a service interruption!

Continme

MPS A:
Enter network values.
U]

&

Using the up and down arrows, scroll through the text fields, entering the desired
values ( to enter the netmask, highlight the field and then use the enter key or right

Loaggaklagggal:
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arrow key to display the dropdown menu, choose the desired value from the list)
for each fields:

n Number: LE11111111

7 192.168.60.250
IF: 192.168.60.3 H [255.255.255.0

C IP: 192.168.60.4 He k: [255.255.255.0_ ]

Hetwork
N ID:
le 192 _.168.59.250 [e]

APP IP: 192.168.59.3 H c: [255.255.255.0

APP IP: 1952_.168.59.4 H I 255.255.255.0

: 192.168.59.5
Hetwork

5 VLAN ID:

[255.255.255.0_ ]

: [255.255.255.0 ]

Start Owver

Note: The System Number shall be as follows:

e LEYYWWMMXX
o  Where:
o LEisthe new System Number Prefix for LSMS
oYY = YEAR — year of the system shipment
o WW=WEEK - calendar week of the Y'Y year when the system
is shipped
o MM =MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle
o XX =number in line of systems shipped that week

*Default route should be the route of the APP IP address.




Once the values are entered press the down arrow to select the “Submit™ button
and press the right arrow to follow the link.

MPS A: Apply network
settings
] g

o1

If the values pass a sanity test for validity, then the “Confirm” button will be
visible. Use the down arrow to select “Confirm” and press the right arrow to apply
the changes. If the sanity tests failed, the reasons will be stated. Use the left arrow
key to go back to the edit screen.

a service interruption'

S5tart Over

The execution could take a few minutes, be patient. The screen will eventually
report the status of the completion. If an error occurs, contact My Oracle Support
following the instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.
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MS Net Jldmin
LE11111111
single

lemspri

Use arrow keys to move, ? ely o O quit '<-' to go batk.l

NOTE: If below error is observed after network configuration, run “systemctl
restart network” command after exiting from Ismsmgr menu.

# systemctl restart network

IS

MPS A: Exit the Ismsmgr
menu

Select Exit and press [ENTER] to return to the Main Menu.
| Network Configuration Menu |4

Hetwork Reconfiguration
SHMP Configuration
Routing

HTE

IPSEC Configuration
Modify Hosts File

Select Exit and press [ENTER]. The “platcfg” utility terminates.




—] Main Menu ——

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Network Configuration

This procedure is complete!

Procedure 16 TMN TOOLKIT AND MARBEN OSI LICENSE INSTALLATION

Note: Valid licenses need to be installed on both A and B LSMS servers. Refer to LSMS 14.0 Release Notes,
section 3.3: Marben OSI and TMN Toolkit license key files, for details. Be sure to start the process at least 7 days
before the scheduled upgrade date. If needed, temporary TMN Toolkit and Marben OSI licenses are available on
the Oracle Software Delivery Cloud (edelivery.oracle.com) with the LSMS software.

Procedure 16 - TMN Toolkit and Marben OSI License Installation

$ This procedure will install the TMN Toolkit and Marben OSI License to both A and B LSMS servers.
E
P Estimated time: 5 minutes
#
L MPS X: Logintothe | Login: EQO'C d
|:| |:| server as the user “root” Passworad: <root_password>
2 MPS X: Install the Copy the TMN Toolkit license file to /usr/local/netech/etc/license path following any steps
Ol O TMN toolkit license file| mentioned in 3.7C.1 or 3.7C.2
If upgrading from LSMS 14.0.0.X release copy backed up licenses on respective paths, there
will be no need to procure new licenses.
Open the file ‘/usr/local/netech/etc/license’ using vi or vim and copy the content of
license in the file and save the file.
Cross check the content of file using :
# cat /usr/local/netech/etc/license
3. MPS X: Install the
Ol O Marben OSI License Copy Marben OSI License string using below command:
file # echo "<Marben 0SI Ticense string>" > /usr/TKLC/osi/conf/Ticense
4. MPS X: Restart the Reboot the system to take effect
system
O o # reboot
This procedure is complete!
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Procedure 17 START LSMS SERVICES

Procedure 17 - Start LSMS services

S This procedure starts the LSMS services.
E Estimated time: 10 minutes
P
#
1 MPSA: Logintothe | Login: EIQO‘C d
. server as the user Password: <root_password>
“root”.
5 MPS A : Check Run below command to check Tsms status is UNINITIALIZED
: "INHIBITED" before running startNode
n hastatus
# hastatus
UNINITIALIZED
if status is UNINITIALIZED and not UNINITIALIZED "INHIBITED" run
hafailover else continue with Step 3.
# lusr/TKLC/plat/sbin/hafailover --inhibit
# hastatus
UNINITIALIZED "INHIBITED"
3 MPS A: # su - Tsmsmgr
0 Start Ismsmgr
4. MPS A: Start Node On the “Main Menu”, select Maintenance and press [ENTER].
O - This will make node Hain Hesu

active and start
application

Initial Comnfiguration

Diagnostics

Server Configuration
Network Configuration
Exit

Select Start Node and press [ENTER].
Maintenance Menu

LSM5 Node Status

Start Hode

Stop Node

Inhibit Hode
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]




4' Start Hode Ii

Confirm Node Startup

Select Exit and press [Enter] to return to Main Menu.
—| Maintenance Menu |—

LSMS Node Status
Start Node

Stop HNode

Inhibit Node
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

5 MPS A: #ssh mate
: Switch to mate
[
6 MPSB: Logintothe | Login: root
' server as the user Password: <root_password>
[

“root”.
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Procedure 17 - Start LSMS services

7 MPS B: # su - Tsmsmgr
Start Ismsmgr
8. MPS B: Start Node On the “Main Menu”, select Maintenance and press [ENTER].

- This will make node
standby and start
application

4| Main Menu |7

Initial Comfiguration

Diagnostics

Server Configuration
Hetwork Comfiguration
Exit

Select Start Node and press [ENTER].

—4 Maintenance Menu F——

LSMS Node Status

Start Hode

Stop Node

Inhibit Hode
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]

4' Start Hode Ii

Confirm Node Startup

Press Enter once the node is uninhibited successfully.




Select Exit and press [Enter] to return to Main Menu.

LSMS NHode Status
Start Node

Stop HNode

Inhikit Node
Backup and Restore

—| Maintenance Menu |—

Main Menu

Initial Configuration
Maintenance
Diagno=stics
Server Configuration
Hetwork Configuration

Select Exit and press [Enter] to exit the Ismsmgr menu.
I

This procedure is complete!

Procedure 18 POST CONFIGURATION HEALTH CHECK

Procedure 18 — Post Configuration Health Check

H O m-w

Estimated time:5 minutes

This procedure determines the health of the Server after an installation. This procedure will perform a
syscheck on each LSMS server.
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Procedure 18 — Post Configuration Health Check

. Login: root
1 MfsthA and B: L?ﬁ Password: <root_password>
1| into the server as the
user “root”.
] # date
2. | MPS Aand B: Thu May 12 05:55:27 EDT 2016
H Validate date, time and
time zone to ensure
accuracy.
MPS A and B: Execute the following command on both LSMS A and B to verify the HA state of mated
Execute the “hastatus”| LSMS pair.
command to verify the # hastatus
HA state of this server. u
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than
“ACTIVE” and “STANDBY”, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
3. | LSMS Standby server; | Execute the following command to verify that MySQL replication is working correctly
| Verify that the on the STANDBY LSMS server:
STANDBY server’s | # tail /var/TKLC/1sms/Togs/dbreplMon.log
MySQL replicationis | £ MySQL replication is functioning correctly then the following output will be
functioning properly. | opserved, make sure that at least the last line of your output matches the lines below.
Thu May 12 05:58:12 2016 Al1 tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 05:59:19 2016 ATl tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:00:25 2016 Al1 tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:01:32 2016 ATl tests passed on STANDBY
WARNING: If at least the last line of your output does not match the lines above then
do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
4. | MPSA and B: # syscheck
]| Execute syscheck Running modules in class disk...
oK
Running modules in class hardware...
oK
Running modules in class 1smshc...
0K




Running modules in class net...
OK
Running modules in class proc...
OK
Running modules in class services...
OK
Running modules in class system...
OK
Running modules in class upgrade...
oK
e LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log

LSMS Active server:

]| Capture the output of
‘sentry status’
command

o

Execute the following command on the ACTIVE LSMS server to display the current
LSMS sentry status:

# sentry status

NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment field. If
the output from this command displays any other Status than “running” contact My
Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

This procedure is complete!

3.7 Data Migration

Procedure 199 RESTORE DATABASE

Procedure 19 - Restore Database

user “root”.

] | Log in to the server as the

$ This procedure restores the database on the LSMS server.
E | Estimated time:60 minutes

p

#
1. MPS A server: Login: root

Password: <root_password>

N

MPS A server:

SErver.

1| Copy the snapshot files
from the Remote server to
the current LSMS Active Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,

Transfer all the NPAC region DB snapshot files, supDB MySQL dump and users
MySQL dump from the Remote server to current LSMS A server.

NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
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# scp —-p hoot@<Remote IP>: <Remote IP Path>/mysql-snapshot-
<NPAC region>.tar.gz /var/TKLC/Tsms/free
Password: <root_password>

# scp -p root@<Remote IP>:<Remote IP Path>/supDBdump.sql
/var/TKLC/1sms/free
Password: <root_password>

# scp —-p root@<Remote IP>:<Remote IP Path>/
MySQLUserGrants.sql /var/TKLC/1sms/free

Password: <root_password>

Switch user to Ismsadm and create regional DB for all regions that were

3. MPS A server: 4 10 LSMS bef redle
Create DB schema for all connected to efore migration
A : # su — Ismsadm
regional DB for which
restore needs to be done $ npac_db_setup create <region name>
Note: Run above command for all regions
4. MPS A and B server: . . .
Note: Execute this step on Standby LSMS server first followed by the active
[] | Stop LSMS processes LSMS server.

# su — lsmsmgr

4| Main Menu Ii

Initial Configuration

Diagno=stics

Server Configuration
Hetwork Configuration
Exit

—| Maintenance Menu |—

LSMS5 Node Status
Start Hode

Stop Hode

Inhibit Node
Backup and Restore
Exit

I Stop Node I

This could cause a service interruption, are you sure?




Node shutdown completed successfully.

Press any key to continue...

Exit the Ismsmgr menu.

4. | MPS A and B: Execute the following command on both LSMS A and B to verify the HA state of
[] | Execute the “hastatus” mated LSMS par.
command to verify the HA | 4 hastatus
state of this server.
Verify that the hastatus of both the servers is ‘UNINITIALIZED "INHIBITED".
WARNING: If the output from the above command is anything else other, do not
proceed with this procedure and contact My Oracle Support following the
instructions on the Appendix E.
5 MPS A server: # cd /var/TKLC/1sms/free
[] | Extract the snapshot data
from the archive tar files Restore the <regionDB> with the regional database name (For example:
copied from LSMS. CanadaDB)
P # tar -xzvf /var/TKLC/Tsms/free/mysql-snapshot-
<regionDB>.tar.gz
# scp /var/TKLC/1sms/free/<regionDB>/*MY*
/var/TKLC/1sms/db/<regionDB>
# rm -rf /var/TKLC/Isms/free/<regionDB>
6. | MPS A server: Execute the below commands:
# systemct] start mysqld
[] | Restore supDB and MySQL

Users.

Restore the ‘supDB’
# mysql -udbroot -p[dbroot_password] supDB <
/var/TKLC/1sms/free/supbBdump.sql

mysql -u dbroot -p<mysql_password> supDB -e 'UPDATE LsmsUser
set FirstLogonFlag=1;'

Restore MySQL users
# mysql -udbroot -p[dbroot_password] <
/var/TKLC/1sms/free/MysSQLUserGrants.sql

# systemct] stop mysqld

Note: Below warning message can be ignored if displayed:
warning: Using a password on the command line interface can
be insecure.
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7. MPS A server: .
) Remove the snapshot files.
] | Remove the snapshot files
# cd /var/TKLC/1sms/free
# rm —f mysqgl-snapshot-*
# rm —f supbBdump.sql
# rm -f MySQLUserGrants.sql
8. | MPS Aserver: verify dbadm:dbadm ownership of all database files and
[] | Check ownership of directories.
database files # cd /var/TKLC/Tsms/db
# 1s -1tr <DB Name>
where <DB NAME> is supDB or <region>DB,
where <region> is the name of an NPAC region.
If any databases have ownership other than dbadm:dbadm, change them using
this command:
# chown -R dbadm:dbadm <DB NAME>
9. | MPS A and B server: . .
Note: Execute this step on LSMS A server first followed by LSMS B server.
[] | Start LSMS processes
# startNode
10. | MPS A and B: .
Execute Procedure 18 to verify the system health check after DB full upgrade.
] | System Heath Check
11. | LSMS Active server: . .
. Login to LSMS Active GUI as Ismsall user.
]| Login to LSMS GUI
12. | LSMS Active server: .
. Refer to the recorded value of MySQL Port in 28 Procedure 6 step 11.
[ | Configure MySQL Port If the MySQL Port is default port, then skip the next step.
Otherwise, go to “Admin -> MySQL Port -> Modify” and configure the port
recorded from LSMS 13.5.X.
13. | LSMS Active server: ) i
. Go to “Configure -> LNP System -> EMS -> View” to verify the ELAP
[ gfgé%:?aisELAP Credentials are identical to the recorded value of the ELAP Credentials in

Procedure 6step 12.

Otherwise, go to “Configure -> LNP System -> EMS -> Modify” and configure
the ELAP Credentials recorded from LSMS 13.5.X.

Note: Re-configure the EMS on LSMS with the details captured in Procedure 6,
step 8.

This procedure is complete!

Procedure 20 CONNECT LSMS 14.0.X TO NPAC

Procedure 20 - Connect LSMS to NPAC

S
T
E
P
#

This procedure connects the LSMS to the NPAC.

Estimated time:15 minutes




NOTE: Execute this procedure only when the NPAC region is not visible on the LSMS GUI, after the DB is restored.
[] | Verify LSMS installation . ] ]
1. LSMS 14.0.X is successfully installed and configured.
2. NAS is successfully installed and configured.
2. | LSMS Active server: . .
. . Login to LSMS Active GUI through VIP as Ismsall user.
1| Login to LSMS Active GUI
3. | LSMS Active server: . i
[] | Update NPAC Customer ID Click on the NPAC region. _
if required Go to the menu Configure -> LNP System -> LSMS -> Modify
Enter the new LNP SPID in the ‘NPAC Customer ID’ field and fill appropriate
Note: If after restore NPAC | information in all other fields.
ID is coming as it was
before starting upgrade skip (Modify LNP Syster LSMS
this step
NPAC Customer 1D
Component info Contact Info
System Type LEMS Owmner 1D THLC
Platform Type LEMS Platform Supplier Oracle
Platform SW Release 130 Platform Model 1.(
f ? Modify LSMS Componenmt?
oK Cancel
4. | LSMS Active server: . ]
[] | Create NPAC region(s) and Click on the NPAC region. _ _
connect it to the NPAC Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Enter the NPAC IP in the ‘NSAP’ field and NPAC FTP Address and check the
‘Activate Region’ checkbox. Fill the information in all other tabs.

Full Upgrade for LSMS 14.0

14.0

082



& Modify LNP System NPAC <MidAtlantic, primary= ==

SMS Name |Mid-Atlantic Regional NPAC SMS | [¥] Activate Region

l’Address Info rCumpnnent Info r Contact Info r Comm Info |
MPAC OS] Address

PSEL [cwl | SSEL[owl | TSEL| | nsap (10 248 |10 |5

Lims O3] Address

PSEL psel 55EL ssel TSEL MNaAF 10 248 10 78

MPAC FTP Address

[1o Jz48 |10 |5 |

E Modify NPAC Component?

| oK || Cancel|

This procedure is complete!

Procedure 21 EXPORT THE DATABASE FROM LSMS 14.0.X TO THE QUERY SERVER

Procedure 21 — Export the Database from LSMS 14.0.X to the Query Server

HUOm—w

This procedure provides the steps to export the database from the LSMS 14.0.X system to the query server.
Estimated time:30 minutes

LSMS Active server:
] | Login as root.

=

Login to LSMS 14.0.X CLI as root user.

2. LSMS Active server: # / /TKLC/1 /£ / 1 hot-*

[] | Remove th_e existing DB # :nn /:,’:: /TKLC/ 15:: /sfre]:j:n:gisnc{fo :Iq]? PR
snapshot files

3. LSMS Active server: # 1smsdb -c snapshot

[ 1| Create a snapshot

WARNING: This command may cause a brief interruption in
traffic being sent

from the NPAC to connected network elements and local LSMS
provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...
lvcreate -- WARNING: the snapshot will be automatically
disabled once it gets full

Tvcreate -- INFO: using default snapshot chunk size of 64 KB
for "/dev/vgapp/dbbackup"

Tvcreate -- doing automatic backup of "vgapp"

lvcreate -- logical volume "/dev/vgapp/dbbackup"
successfully created

The database is available to the application again.




Disk sna?shot created successfully.
mount: block device /dev/vgapp/dbgackup is write-protected,
mounting read-only

Snapshot mounted successfully.

Created snapinfo.sql file successfully
CanadabDB/

CanadabB/db.opt
CanadabDB/Subscriptionversion. frm
CanadabDB/Subscriptionversion.MYI
CanadabDB/Subscriptionversion.MYD
CanadabDB/NumberpPool1Block. frm
CanadabB/NumberpPool1Block.MYI
CanadabB/NumberPool1Block.MYD
CanadaDB/ServiceProvNetwork. frm
CanadaDB/ServiceProvNetwork.MYI
CanadaDB/ServiceProvNetwork.MYD
CanadaDB/ServiceProvLRN.frm
CanadaDB/ServiceProvLRN.MYI

f%runcated )
Tvremove -- doing automatic backup of volume group "vgapp"
Tvremove -- logical volume "/dev/vgapp/dbbackup"

successfully removed

LSMS Active server:
] | Verify the snapshot

&

# cd /var/TKLC/1sms/free

[root@Ismspri freel# 1s
mysql-snapshot-SouthwestDB.tar.gz
mysql-snapshot-supDB.tar.gz
mysql-shapshot-CanadaDB.tar.gz
mysql-snapshot-westCoastDB.tar.gz
mysql-snhapshot-MidAtTlanticDB.tar.gz
snapinfo.sql
mysql-snapshot-MidwestDB.tar.gz
mysql-snapshot-NortheastDB.tar.gz
mysql-snhapshot-SoutheastDB.tar.gz

5. LSMS Active server:
] | Copy snapshot files to
LSMS 14.0.X Query Server

or a Remote Server.

Transfer all the NPAC region DB snapshot files.

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB

# scp -p /var/TKLC/Tsms/free/mysql-snapshot-<NPAC
region>.tar.gz root@<Query Server IP>:/usr/mysqll

# scp -p /var/TKLC/1sms/free/snapinfo.sql root@<Query
Server IP>:/usr/mysqll

or

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computers...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>

sftp> put mysql-snapshot-<NPAC regjon>.tar.gz
Uploading mysql-snapshot-<NPAC region>.tar.gz
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sftp> put snapinfo.sq]
Uploading snapinfo.sql

Extract the data for EACH
region. Replace regionDB
with regional database name

Remove each tar.gz after it
has extracted.

sftp> bye

6. | LSMS 14.0.X Query Jogin: root
] Server: Password:<root_password>

Login as root to the Query

Server
7. | LSMS 14.0.X Query # cd /opt/mysql/mysql/bin
] Server: # ./mysqladmin -u root -p shutdown

Shutdown the Mysgl server | Enter password:
8. | LSMS 14.0.X Query # cd Jusr/mysqll
] Server: # gunzip -c mysql-snapshot-<regionDB>.tar.gz | tar -xvf -

# rm mysql-snapshot-<regionDB>.tar.gz

9. | LSMS14.0.X Query # cd /opt/mysql/mysql/bin
] Server:
Start the Mysql daemon on
the Query Server. # ./mysqld_safe --skip-replica -start &
1255
# Starting mysqld daemon with databases from /usr/mysqll:
10. | LSMS 14.0.X Query # ./mysql -u root -p
] Server:
Start the Mysql command
line utility mysql> RESET BINARY LOGS AND GTIDS;
Query OK, 0 rows affected (0.23 sec)
Reset the configuration
information for master
mysql> reset replica;
Query OK, 0 rows affected (0.19 sec)
Reset the configuration
information for slave mysqgl> source /usr/mysqll/snapinfo.sql
Query OK, 0 rows affected (0.17 sec)
Configure the query server
to start replication from the
correct position on the
master.
LSMS Active server: As
11 - - ¥*
Ll the root user, remove the [root@lsmspri root]# rm /var/TKLC/1sms/free/mysql-snapshot

intermediate tarballs from
the LSMS 14.0.X server.

As the root user, remove the
snapinfo.sql script from the
LSMS 14.0.X server

[root@Ismspri root]# rm /var/TKLC/lsms/free/snapinfo.sql




12. | LSMS 14.0.X Query NOTE :
] Server: EMS changes may cause the Query server to disconnect. These

Start the Mysgl command steps will help prevent the disconnect.

line utility Togin: root

# 9opt/mysq1/mysq1/bin/mysq1 -u root -p

13. | LSMS 14.0.X Query mysql> SET GLOBAL SQL_REPLICA_SKIP_COUNTER = 100;
[]| Server: Query OK, O rows affected

Prepare the Query Server

for the EMS Configuration
14. | LSMS 14.0.X Query Perform Error! Reference source not found..
] Server:

Validate the operation of the

query server.

This procedure is complete!

Procedure 22SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

STEP | This procedure exchanges SSH keys between the ELAP and LSMS 14.0 (TPD 8) .
#
Note: This Procedure is only required when ELAP version is 10.2. Skip this procedure if ELAP version is 11.x
Estimated Time: 15 mins
Should this procedure fail, Contact Oracle technical services and ask for FULL UPGRADE ASSISTANCE.
: . Togin: elapdev
L Active ELAP: Password: <elapdev_password>
Login as elapdev.
. . NOTE: RSA keys don’t exist on OL6 server ELAP 10.2. To
2. Active ELAP: exchange keys with LSMS 14, we need to generate RSA keys
Generate RSA keys on first on ELAP 10.2 server.

ELAP 10.2 server

Please run below commands on the Active ELAP to generate
RSA keys on ELAP A and B servers.

1. Go to elapdev home directory using cd command.
cd

2. Generate key on local ELAP.
/usr/bin/ssh-keygen -t rsa -f .ssh/id_rsa -N "'

3. Generate key on remote ELAP

T i

Example:
[elapdev@Iithaca-A ~]$ cd

[elapdev@Ithaca-A ~]$ /usr/bin/ssh-keygen -t rsa -f
.ssh/id_rsa -N "'

ssh mate "/usr/bin/ssh-keygen -t rsa -f .ssh/id_rsa -N
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Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Generating public/private rsa key pair.

Your identification has been saved in .ssh/id_rsa.
Your public key has been saved in .ssh/id_rsa.pub.
The key fingerprint 1is:

3e:d0:ea:25:fc:84:66:ff:4c:16:00:16:99:c8:ed:af
elapdev@Iithaca-A

The key's randomart image is:
+--[ RSA 2048] ------ +
. O++

O.+.

I I
I I
I I
| e |
| ..S . |
I I
I I
I I
I I

[eTapdev@Ithaca-A ~]# ssh mate "/usr/bin/ssh-keygen -t rsa
-f .ssh/id_rsa -N "' “

3. Active ELAP:

Verify that the keys are
generated for elapdev user
on both ELAP A and B
Serves.

Check that rsa keys are generated for the elapdev user on
Tocal and mate using below command.

Run below commands to verify the keys.
$ 1s -1rt .ssh/id_rsa*
$ ssh mate 'ls -1rt .ssh/id_rsa*'

Example:

[eTapdev@Crete-A ~]$ 1s -Trt .ssh/id_rsa*

-rw-r--r-- 1 elapdev elap 569 Mar 20 08:16 .ssh/id_rsa.pub
-rw------- 1 elapdev elap 2602 Mar 20 08:16 .ssh/id_rsa
[eTapdev@Crete-A ~]$ ssh mate 'ls -1rt .ssh/id_rsa*'
-rw-r--r-- 1 elapdev elap 569 Mar 20 08:17 .ssh/id_rsa.pub
-rw------- 1 elapdev elap 2602 Mar 20 08:17 .ssh/id_rsa




Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

4

Active ELAP:
Exchange Secure Shell
Keys with LSMS 14.0

SSH keys will first be
exchanged between ELAP A
and LSMS A and then
between ELAP B and LSMS
A

Exchange secure shell keys with LSMS A server using below
command.
Run below commands to exchange keys with LSMS.

1. Exchange key with local ELAP and LSMS.

/usr/TKLC/plat/bin/keyexchange 1smsadm@lsmsAIpAddr --
key=id_rsa.pub 2>&1

2. Exchange Key with remote ELAP and LSMS

/usr/bin/ssh -1 elapdev mate -t
"/usr/TKLC/plat/bin/keyexchange Tsmsadm@lsmsAIpAddr --
key=id_rsa.pub 2>&1"

Example:

[eTapdev@Ithaca-A ~]$ /usr/TKLC/plat/bin/keyexchange
Tsmsadm@10.75.140.10 --key=id_rsa.pub 2>&1

The server does not know of 10.75.140.10.

will just exchange host keys for the name given!
Password of Tsmsadm:

ssh is working correctly.

Active ELAP:
Exchange Secure Shell
Keys with LSMS 14.0

SSH keys will next be
exchanged between ELAP A
and LSMS B and then
between ELAP B and LSMS
B

Exchange secure shell keys with LSMS B server using below
command.

Run below commands to exchange keys with LSMS.
1. Exchange key with local ELAP and LSMS.

/usr/TKLC/plat/bin/keyexchange 1smsadm@lsmsBIpAddr --
key=id_rsa.pub 2>&1

2. Exchange Key with remote ELAP and LSMS
/usr/bin/ssh -1 elapdev mate -t

"/usr/TKLC/pTat/bin/keyexchange 1smsadm@]lsmsBIpAddr --
key=id_rsa.pub 2>&1"

Example:

[elapdev@Iithaca-A ~]$ /usr/TKLC/plat/bin/keyexchange
Ismsadm@10.75.140.11 --key=id_rsa.pub 2>&1

The server does not know of 10.75.140.10.

will just exchange host keys for the name given!
Password of Tsmsadm:

ssh is working correctly.

Active ELAP:

Note down date and
timestamp

$date

This procedure is complete!
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Procedure 2 CONNECT LSMS 14.0.X TO ELAP

Procedure 22 - Connect LSMS to ELAP

$ This procedure connects the LSMS to ELAP.
E | Estimated time:10 minutes
p
#
7. | ELAP Active server: Lodin to ELAP GUI th B VIP as uiadmi
[7 | Login to ELAP GUI oginto roug as uiadmin.
8. ELAP Active server: Got Maint LSMS C i - Enzbled
0 to menu Maintenance -> onnection -> ange £napble
[ | Enable the LSMS Click on ‘Enable LSMS Connection’ button.
Connection
ELAP_A_NAME Change LSMS Connection Allowed
i INFO: The L3MS Connection is currently Disabled.
& CAUTION: This actien will Enable the LSS Connection
S 2013 @ Tekelec, Inc, Al Rights Reserver d.
ELAP_A NAME Change LSMS Connection Allowed
V SUCCESS: The LEMS Connection is now Enabled.
r 27 2013 02:03:19 EST
2013 @ Tekelec, Inc, All Rights Reserve d.
o | ELAP Active server: Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
Click on ‘Enable LSMS Bulk Download for the ELAP’ button.
Enable the bulkload.
ELAP_B_NAME Change LSMS HS Bulk Download Enabled
i INFO: The LSMS Bulk Download for this ELAP is currently Disabled.
A CAUTION: This action will Enable the LSMS Bulk Download for this ELAP_
‘ Enable LSMS Bulk Download for this ELAP
Thu June 0% 2016 08:50:33 EDT
Copyright & 2015-2016, Oracle and/or its affiliates. All rights reserved.
After clicking on the button,success message will be displayed.
SUCCESS The LSMS HS Bulk Download is now enabled.

This procedure is complete!

Procedure 24 ACCEPT THE UPGRADE

Procedure 23 — Accept the upgrade.

HF OmMm-—Awn

This procedure will accept the upgrade.
Estimated time: 5 minutes




Procedure 23 — Accept the upgrade.

1 MPS X: Log in to the server
O Ol 2 the user “root”.

Login: root
Password: <root_password>

# su - platcfg

2. MPS X: Start platcfg
Ol ] utility.
3 MPS X: Accept Upgrade
O O On the “Main Menu”, select Maintenance and press [ENTER].

Main Menu

Diagnostics

Server Configuration
Network Configuration
Eemnte Consoles

Exit

Select the “Upgrade” menu and press [ENTER].
Maintenance Menu

Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Exit

Select the “Accept Upgrade” menu and press [ENTER].
4| Upgrade Menu Ii

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USE Upgrade Image
Hon Tekelec RPM Management

Reject Upgrade
Exic

Note: The “Reject Upgrade” menu is also available after the LSMS installation.
However, this option should not be used after the first installation of application. It
should be used in subsequent upgrades to return to a previous application release.

Select Yes and press [ENTER].
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Procedure 23 — Accept the upgrade.

I Main Menu I

Do you really want to accept the upgrade?

t
1=
e

This procedure is complete!




APPENDIX A. ISO IMAGE COPY FROM USB MEDIA

Assumption: The USB media contains the desired LSMS ISO.

A.1 ISO IMAGE COPY FROM USB MEDIA

Appendix A.1 - ISO Image copy from USB media

S This procedure provides instructions to copy an 1ISO image from an USB media.
T
E|1A| 1B
P
#
1. | OO O | MPS X: Insert Insert media in USB drive
USB.
2. | | | MPSX: Loginto [hostname] consolelogin: root
the server as the password: password
“root” user.
3. | [ | MPSX:Run Execute the following command:
syscheck tomake | # syscheck
sure there is no The output should Took Tike:
error. [root@hostname ~]# syscheck
Running modules in class proc...
oK
Running modules in class services...
oK
Running modules in class system...
oK
Running modules in class disk...
oK
Running modules in class hardware...
oK
Running modules in class net...
0K
LOG LOCATION: /var/TKLC/log/syscheck/fail_Tlog
4.1 [ | [ | MPS X: Verify ISO| Execute the following command to perform directory listing:
already exist The output should look like:
[root@hostname ~]# 1s -al /var/TKLC/upgrade
total 16
dr-xr-xr-x 2 root root 4096 Oct 22 16:31 .
dr-xr-xr-x 21 root root 4096 oct 18 13:40 ..
If an ISO image exists, remove it by executing the following command:
# rm -f /var/TKLC/upgrade/<ISO image>
5 | | [ | MPS X: Delete Execute the following command to create a directory to mount the USB media:
unwanted 1SOs # mkdir -p /mnt/usb
from USB media. ) )
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl * 1 812 831472 6
FAT16
Execute the following command to mount the USB media using the USB drive
name from the output above:
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# mount /dev/sdcl /mnt/usb

Execute the following command to perform directory listing and verify the file

name format is as expected:
# 1s -al /mnt/usb

The output should look like:

[root@hostname ~]# # 1s -al /mnt/usb

total 629400

dr-xr-xr-x 2 root root 4096 Dec 5 13:33 .

dr-xr-xr-x 22 root root 4096 Dec 5 13:55 ..
-rw-r--r-- 1 root root 829595648 Dec 5 16:20 LSMS-
14.0.0.0.0_140.6.5-x86_64.1s00nly one ISO file should be listed, if
additional files are listed, execute the following command to remove unwanted

I1SOs:
# rm -f /mnt/usb/<ISO_NAME>.1s0

Fore.g.,
# rm -f /mnt/usb/ LSMS-14.0.0.0.0_140.6.5-x86_64.17so

MPS X: Verify
space exists for
ISO.

Execute the following command to verify the available disk space:
# df -h /var/TKLC

The output should Took Tike:
[root@Ismspri Togl# df -h /var/TKLC
Filesystem Size Used Avail Use% Mounted on
/dev/mapper/vgroot-plat_var_tklc
3.9 1.2G 2.5G 32% /var/TKLC

Verify that there is at least 620M in the Avail column. If not, clean up files
until there is space available.

CAUTION: Make sure you know what files you can remove safely before
cleaning up. It is recommended that you only clean up files in the
/var/TKLC/upgrade directory as this is a platform owned directory that
should only contain 1SO images. This directory should not be expected to
contain images for any length of time as they can get purged. Contact
Technical Services beforehand if removing files other than the
Ivar/TKLC/upgrade directory as removing files is dangerous.

Copy iso from
mounted path to
the destination
path

Execute the following command to copy ISO:
# cp /mnt/usb/<xyz.iso> /var/TKLC/upgrade/

Execute the following command to unmount the USB media:
# umount /mnt/usb

MPS X: Verify ISO
image exists.

Execute the following command to perform directory listing:
# Is —al /var/TKLC/upgrade

The output should look like:

The output should look like:
[root@lsmspri logl# 1s -al /var/TKLC/upgrade
total 895152

drwxrwxr-x. 2 root admgrp 4096 Apr 20 17:16 .
dr-xr-xr-x. 20 root root 4096 Apr 20 18:01 ..
—r-——————- 1 admusr admgrp 916621312 Apr 20 17:16 LSMS-

14.0.0.0.0_140.6.5-x86_64.17s0

Repeat this procedure from step 5 if LSMS 1SO file is not as expected.




9. | 1| [ | MPS X: Logout Logout from the server by executing the following command:
from server.
# Tlogout
10.{ ]| [ | MPS X: Remove Remove media from USB drive.
USB media.

This procedure is complete!

A.2 Copying LSMS backups from NAS to USB

S This procedure provides instructions to copy LSMS backups from NAS to USB.
T
£ | NAS
P
#
1.| [J | NAS: Insert USB. | Insert media in USB drive
2.| [J | NAS: Login to the [hostname] consolelogin: root
server as the “root”| password: password
user.
3. [ | NAS:Run Execute the following command:
syscheck to make | # syscheck
sure there is no The output should Took Tike:
error. [root@hostname ~]# syscheck
Running modules in class proc...
oK
Running modules in class services...
oK
Running modules in class system...
oK
Running modules in class disk...
oK
Running modules in class hardware...
oK
Running modules in class net...
oK
LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log
4.1 [] | NAS: Mountthe Execute the following command to create a directory to mount the USB media:
USB media. # mkdir -p /mnt/usb
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl  * 1 812 831472 6
FAT32
Execute the following command to mount the USB media using the USB drive
name from the output above:
# mount /dev/sdcl /mnt/usb
Note: There should be space available in the USB. If not, clean up files until
there is space available.
5.1 [] | Copy backupfiles | Execute the following command to copy ISO:
to the mounted # cp <backup files> /mnt/usb/
path
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While copying backup files to USB, Following error is expected:

cp: failed to preserve ownership for “/mnt/usb/<backup_file>': Operation
not permitted

Note: Please note the ownership of the backup files before copying. Therefore,
after restoring the backups to server after IPM’ing, verify the ownership of
backup files. If not matched, change the ownership with the “chown” command.

NAS: Verify
backup files exists

Execute the following command to perform directory listing:
# Is —al /mnt/usb/

List of backup files should be displayed.

Execute the following command to unmount the USB media:
# umount /mnt/usb

NAS: Logout from
server.

Logout from the server by executing the following command:

# Togout

NAS: Remove
USB media.

Remove media from USB drive.




APPENDIX B. START AND VERIFY REPLICATION ON QUERY SERVER

Appendix B — Start and Verify REPLICATION ON Query Server

Query Server:
D Start Replication.

D Verify the replication
status on the Query
Server.

NOTE:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to YES, the status is
good and the next
step can be skipped.

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to NO, wait a few
minutes and then
repeat the “show
slave status \G;”
command

If the values are still
NO, proceed to the
next step.

mysql> start slave;

S | This procedure provides the steps to start and verify Replication on the query server
T
E | This step is performed only if a query server exists in the customer system.
P | Estimated time:30 minutes
#
1. | LSMS14.0.X

Query OK, 0 rows affected (0.00 sec)

mysql> show slave status \G;
deded kel dehddedefhd N dd N hddn
Slave_IO_State:

Master_Host:

Master_uUser:

Master_Port:

connect_Retry:
Master_Log_File:
Read_Master_Log_Pos:
Relay_Log_File:
Relay_Log_Pos:
Relay_Master_Log_File:
Slave_IO_Running:
Slave_SQL_Running:
Replicate_Do_DB:
Replicate_Ignore_DB:
Replicate_Do_Table:
Replicate_Ignore_Table:

1_ row Teddede NS defehdedehde N hddehdd i
waiting for master to send event
<Master Host IP>
Tsmsrepl
3306
60
mysql-bin.000134
15778725
cs2-bss2-relay-bin.000001
4137221
mysqgl-bin.000134
Yes
Yes

ResyncDB,mysq]

SupDB.LsmsUsersSpid, supDB.LsmsUser,supbDB.DbConfig

Replicate_Wwild_bo_Table:
Replicate_wild_Ignore_Table:
Last_Errno:
Truncated..........
Seconds_Behind_Master:
1 row in set (0.00 sec)
mysql>

ResyncDB.%,supDB.%Key,mysql.%
1008

NULL
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LSMS 14.0.X
Query Server:

OPTIONAL:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to NO, the status is
not good and the
error will need to be
investigated.

Look at last few lines
of error log, and
record the error.

# tail /usr/mysqll/*.err

Record error here:

Contact My Oracle Support following the instructions on the Appendix E and ask for
FULL UPGRADE ASSISTANCE.

w

LSMS Active
Server:

Login to the LSMS
Primary server as
Ismsadm.

Verify the Query
Server is Connected.

Login: 1smsadm
Password: <lsmsadm_password>

[1smsadm@lsmspri Ismsadm]$ 1smsdb -c queryservers
cs2-bss2 (<Query Server IP>) Connected




APPENDIX C. COPYING LICENSE FILE ON THE LSMS SERVER

C.1 Copying File Using SCP

S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. | Server X: Login to Loging to server using 1D and password where license file is copied
LJ| server where license file
is present
2. | server X: SCPthefile | scp <license file> root@<LSMS IP>: /usr/Tocal/netech/etc/Ticense
LI| from server to LSMS
server
3. | LSMS MPS: Check if | Run command to check for license file :
U the license file has been | $ cat /usr/local/netech/etc/license
copied correctly Expected Output : _
Contents of license file should be displayed
This procedure is complete!
C.2 Copying File Using USB
S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. | Server X: Copy license | Connect USB to desktop and copy the license file from desktop to USB.
| file to USB

I:l!\’

LSMS MPS: Confirm
how the USB is
enumerated on LSMS
server

Connect the USB to LSMS MPS which contains the license file and check on how it is
enumerated using command :

$dmesg | grep -i “removable disk"

Expected output

sd 6:0:0:0: Attached scsi removable disk sdc

This shows USB is enumerated as /dev/sdc

DP’

LSMS MPS: Determine
the partition name

Run command fdisk —I on enumerated name device to determine partition name :
$fdisk —I /dev/sdc

Expected Output :

Disk /dev/sdc: 2013 MB, 2013265920 bytes

256 heads, 63 sectors/track, 243 cylinders
Units = cylinders of 16128 * 512 = 8257536 bytes

Device Boot Start End Blocks Id System
/dev/sdcl 1 110 887008+ b w95 FAT32
This shows that partition name is /dev/sdcl
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copied correctly

4. [ LSMS MPS: Copy Run below command to copy the license file from USB
L] ticense file from USB to | $mkdir —p /tmp/usb
MPS $ mount /dev/sdcl /tmp/usb
5. | LSMS MPS: Copy $ cp /tmp/usb/<Ticense-file> /usr/Tocal/netech/etc/license
L] ticense file from ftmp
directory
6. | LSMS MPS: Check if | Run command to check for license file :
[ thelicense file hasbeen | $ cat /usr/local/netech/etc/Ticense

Expected Output :
Contents of license file should be displayed

|:|.\1

LSMS MPS: Unmount
the USB

Unmount the USB using command :
$umount /tmp/usb

This procedure is complete!




APPENDIX D. SWOPS SIGN OFF.

Discrepancy L.ist

Date

Test
Case

Description of Failures and/or Issues.
Any CSR’s / RMA’s issued during
Acceptance. Discrepancy

Resolution and SWOPS
Engineer Responsible

Resolution
Date:
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APPENDIX E. MY ORACLE SUPPORT

ACAUTION: Use only the guide downloaded from the Oracle Technology Network (OTN)
(http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html).

Before upgrading your system, access the My Oracle Support web portal (https://support.oracle.com) and review any
Knowledge Alerts that may be related to the System Health Check or the Upgrade.

Before beginning this procedure, contact My Oracle Support and inform them of your upgrade plans. If installing for an
Oracle customer on a customer site, obtain the customer's Support Identifier (SI) before requesting assistance.

Web portal (preferred option): My Oracle Support (MOS) (https://support.oracle.com/)

Phone: Contact your local Oracle Global Customer Support Center (http://www.oracle.com/support/contact.html)

Make the following selections on the Support telephone menu:

1. Select ‘2’ for New Service Request
2. Select ‘3’ for Hardware, Networking and Solaris Operating System Support

3. Select 1’ for Technical Issues and when talking to the agent, please indicate that you are an existing
Tekelec customer


http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html
https://support.oracle.com/
https://support.oracle.com/
http://www.oracle.com/support/contact.html

